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1

HISTORIA ZMIAN

Data

Wersja

Zmiany

31.08.2023

v_1 23 _003_PL

dodanie metody GiveMeAllLocationWithAllData zwracajacej liste
punktdéw z rozszerzonym opisem

01.07.2023

v_1 23 002_PL

dodanie metody GetAvailablePickups zwracajacej liste
zamoéwionych podjazdéw.

12.04.2023

v_1 23 001_PL

dodanie metody GiveMeShippingCodeStatusFullHistory i
PutCustomerShippingCodeCanceled

16.01.2023

v_1_22_003_PL

dodanie metody CallPickup stuzgcej do zamdwienia podjazdu
kuriera.

14.07.2022

v_1 22 002_PL

dodanie nowego punktu odbioru o typie <PointType> PPK
akceptujgcego gabaryty S, M i L. Punkty PPK nie obstuguja
nadan. Informacja o obstudze wytacznie odbioréw jest zwracana
w Opisie Lokalizacji <Location>.

25.05.2022

v_1 22 001_PL

dodanie nowej metody GiveMeAIIRUCHWi thFilledD1
umozliwiajacej pobranie listy punktow spetniajacych kryteria
dostawy w czasie D+1

dodanie nowej metody Ping sprawdzajgcej status potgczenia z
webservice'm API

aktualizacja sekcji '"Wstep' o opis procedury generowania etykiet
zwrotnych

13.10.2021

v_1 16_007_A

dodanie nowej metody GiveMeAIllAPMLocation umozliwiajgcej
pobranie listy wszystkich Automatow Paczkowych dostepnych w
ustudze ORLEN Paczka

dodanie do metod GiveMeAIllIRUCHLocation oraz
GiveMeAIllIRUCHWithFilled nowych typow punktéw <PointType>:
APM (Automaty Paczkowe) oraz PKN (Stacje paliw ORLEN)

dodanie nowych gabarytéw S, M i L do parametru <BoxSize>
wiasciwych dla nowych typéw punktéw APM i PKN
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2 WSTEP

LISTA PUNKTOW

W celu pobrania aktualnej listy punktéw rekomendujemy wykorzystanie metody
GiveMeAIlIRUCHWithFilled, ktdra zwrdci wszystkie punkty dostepne w ustudze ORLEN Paczka,
(réwniez te, ktore sg w danej chwili przepetnione i mogg zosta¢ wkrétce wytgczone) a dodatkowo
wskaze do 5 punktow alternatywnych. Moze to by¢ cenna wskazéwka dla Klienta, sugerujgca
rozwazenie zmiany punktu na sasiadujgcy.

Zalecamy jednoczesnie odswiezanie listy punktéw przynajmniej raz dziennie w celu zachowania
aktualnych danych. Docelowo aktualizacja danych na temat przepetnienia punktéw bedzie
nastepowac kilkukrotnie w ciggu dnia.

Przy wyborze punktu odbioru APM, PKN oraz PPK niezbedne jest wypetnienie pola <BoxSize>
wartoscig S, M lub L. W przeciwnym razie pojawi sie komunikat btedu numer 141, sugerujacy
nieprawidtowy rozmiar wybranej skrytki.

PACZKA ZWROTNA

Aby uzyskac etykiete zwrotng nalezy przy pomocy metody GeneratelabelBusinessPack wypetnic
cztery kluczowe parametry nastepujgcymi wartoSciami:

<DestinationCode>0130</DestinationCode>
<ReturnPack>T</ReturnPack>
<ReturnAvailable>T</ReturnAvailable>
<ReturnQuantity>1</ReturnQuantity>

POWROT PACZKI

Do uzyskania aktualnego numeru paczki powrotnej stuzy metoda GiveMasterPack, opisana na stronie
38.

HISTORIA PACZKI

Do uzyskania petnej historii paczki stuzy natomiast metoda GiveMePackStatusFullHistory, dostepna
na stronie 54.

PACZKA POBRANIOWA

Paczki pobraniowe (COD, nieoptacone) mozna zaawizowac i odebrac wytgcznie w Kioskach ,RUCH"” —
punktach o typie <PointType>PSD</PointType>. Podczas préby zaawizowania przesytki na inny niz
PSD punkt, zostanie zwrdcony btad 318: ,no service COD in DestinationCode”.
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3 MeTobpy

3.1 CREATECUSTOMER

Metoda stuzy do tworzenia nowego klienta ORLEN Paczka.

Parametry wywotania:

3.1.1  Wywotanie

<PartneriD>

identyfikator Klienta nadany
przez RUCH

(REQUIRED) 10 char

<PartnerKey> hasto Klienta nadane przez RUCH | (REQUIRED) 10 char
<FirstName> imie odbiorcy 30 char
<LastName> nazwisko odbiorcy 30 char
<CompanyName> firma odbiorcy 70 char
<Nip> NIP tworzonego klienta (REQUIRED) 10 char
<City> miasto z adresu odbiorcy 30 char
<StreetName> ulica z adresu odbiorcy 30 char

numer budynku z adresu
<BuildingNumber> odbiorcy 10 char
<PostCode> kod pocztowy z adresu odbiorcy 6 char
<EMail> adres email odbiorcy 60 char
<PhoneNumber> numer telefonu odbiorcy (REQUIRED) 9 char

Podczas tworzenia nowego klienta nalezy wprowadzi¢ nr NIP sktadajgcy sie wytgcznie z 10 cyfr (bez

spacji lub znakéw specjalnych).

Przyktad z minimalng wymagana listg pol:

<PartnerID>1234567890</PartnerID>

<PartnerKey>XAGWEGWw12</PartnerKey>

<FirstName>Jan</FirstName>

<LastName>Nowak</LastName>

<Nip>123-456-78-90</Nip>

<City>Warszawa</City>

<CompanyName>Firma SA</CompanyName>

<StreetName></StreetName>

<BuildingNumber></BuildingNumber>

<FlatNumber></FlatNumber>

<PostCode></PostCode>
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<PhoneNumber></PhoneNumber>

<EMail></EMail>

Zwracane wartosci:

34.2  Odpowiedz

<Err>

numer btedu

<ErrDes>

opis btedu

<NewCustomerPartner|D>

identyfikator utworzonego Klienta

<NewCustomerPartnerKey>

hasto utworzonego Klienta

Przyktad:

<Err>000</Err>

<ErrDes>saved</ErrDes>

<NewCustomerPartnerID> PWR0000001</NewCustomerPartnerID>

<NewCustomerPartnerKey>6EF1E2D424</NewCustomerPartnerKey>

3.2 GENERATEBUSINESSPACK

Metoda stuzy do awizowania podstawowej przesytki ORLEN Paczka.

Parametry wywotania:

3.21 Wywotanie

<PartneriD>

identyfikator Klienta nadany
przez RUCH

(REQUIRED)10 char

<PartnerKey>

hasto Klienta nadane przez RUCH

(REQUIRED)10 char

<DestinationCode>

kod POPeR

(REQUIRED)15 char

<AlternativeDestinationCode> alternatywny kod POPeR 15 char
<ReturnDestinationCode> kod POPeR do zwrotu 15 char

<BoxSize> wielkos$¢ paczki (REQUIRED) 10 char
<PackValue> wartosc przesytki (w groszach) 6 char
<CashOnDelivery> paczka za pobraniem (true/false) boolean
<AmountCashOnDelivery> kwota pobrania (w groszach) 6 char

<Insurance> ubezpieczenie paczki (true/false) boolean
<EMail> adres email odbiorcy 60 char
<FirstName> imie odbiorcy 30 char
<LastName> nazwisko odbiorcy 30 char
<CompanyName> firma odbiorcy 70 char
<StreetName> ulica z adresu odbiorcy 30 char
<BuildingNumber> numer budynku z adresu odbiorcy | 10 char

numer mieszkania z adresu
<FlatNumber> odbiorcy 10 char
<City> miasto z adresu odbiorcy 30 char
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<PostCode>

kod pocztowy z adresu odbiorcy

6 char

<PhoneNumber>

numer telefonu odbiorcy

(REQUIRED) 9 char

<SenderEMail>

adres email nadawcy

(REQUIRED) 60 char

<SenderFirstName>

imie nadawcy

(REQUIRED) 30 char

<SenderLastName> nazwisko nadawcy (REQUIRED) 30 char
<SenderCompanyName> firma nadawcy 70 char
<SenderStreetName> ulica z adresu nadawcy (REQUIRED)30 char

numer budynku z adresu

<SenderBuildingNumber> nadawcy (REQUIRED)10 char

numer mieszkania z adresu
<SenderFlatNumber> nadawcy 10 char
<SenderCity> miasto z adresu nadawcy (REQUIRED) 30 char
<SenderPostCode> kod pocztowy z adresu nadawcy | (REQUIRED) 6 char
<SenderPhoneNumber> numer telefonu nadawcy (REQUIRED) 9 char
<SenderOrders> nr zamowienia nadawcy 30 char
<ReturnEMail > adres email do zwrotu 60 char
<ReturnFirstName> imie osoby do zwrotu 30 char
<ReturnLastName> nazwisko osoby do zwrotu 30 char
<ReturnCompanyName> nazwa firm do zwrotu 70 char
<ReturnStreetName> ulica z adresu do zwrotu 30 char

numer budynku z adresu do
<ReturnBuildingNumber> zwrotu 10 char

numer mieszkania z adresu do
<ReturnFlatNumber> zwrotu 10 char
<ReturnCity> miasto z adresu do zwrotu 30 char
<ReturnPostCode> kod pocztowy z adresu do zwrotu | 6 char
<ReturnPhoneNumber> numer telefonu do zwrotu 9 char

<PrintAdress>

wybdr adresu do wydruku przy
zwrocie (1- adres nadania, 2 -
adres zwrotu)

(REQUIRED) 1 char

<ReturnPack> paczka zwrotna (T -jesli zwrotna) 1 char
tytut przelewu dla paczki za
<TransferDescription> pobraniem 70 char
mozliwos¢ nadania paczki
<ReturnAvailable> zwrotnej (T -jesli tak) 1 char
<ReturnQuantity> liczba paczek zwrotnych 1 char

TransferDescription nie moze zawieraé polskich znakdéw i specjalnych.

Pola <FirstName> i <LastName> sg obowigzkowe, jesli nie podano wartosci w polu <CompanyName>.

Pola <SenderFirstName> i <SenderLastName> sg obowigzkowe, jesli nie podano wartosci w polu

<SenderCompanyName>.

Pole <ReturnDestinationCode> wypetniane jest tyko w przypadku: nadania w PSD i wyborze innego

PSD do zwrotu niz PSD w ktérym paczka zostanie nadana.

Przy wyborze punktu odbioru APM oraz PKN, pole <BoxSize> jest obowigzkowe i przyjmuje wartosci: S,

M lub L.

Przyktad z minimalng wymagana listg pol:

<PartnerlD>1234567890</Partner|D>
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<PartnerKey>XAGWEGWw12</PartnerKey>
<DestinationCode>0130-6556-40-43</DestinationCode>
<FirstName>Jan</FirstName>
<LastName>Nowak</LastName>
<PhoneNumber>123456789</PhoneNumber>
<SenderEMail>test@tt.pl</SenderEMail>
<SenderCompanyName>Firma SA</SenderCompanyName>
<SenderStreetName>Prosta</SenderStreetName>
<SenderBuildingNumber>1234</SenderBuildingNumber>
<SenderCity>Warszawa</SenderCity>
<SenderPostCode>99-999</SenderPostCode>
<SenderPhoneNumber>123456789</SenderPhoneNumber>

<PrintAdress>1</PrintAdress>

3.2.2 Odpowiedz

Zwracane wartosci:

<Err> numer btedu

<ErrDes> opis btedu

<PackCode_RUCH> Numer EAN-13 przesytki

<DestinationCode> Kod POPER (potwierdzenie lub zmiana)

<Destinationld> Kod PSD

<PackPrice> Cena przesytki (w groszach)

<PackPaid> Optacenie przesytki (true/false)
Przyktfad:

11

<Err>000</Err>

<ErrDes>saved</ErrDes>
<PackCode_RUCH>2900000000230</PackCode_RUCH>
<DestinationCode>0130-6556-40-43</DestinationCode>
<Destinationld>123680</Destinationld>
<PackPrice>745</PackPrice>

<PackPaid>false</PackPaid>
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3.3 GENERATEBUSINESSPACKTWO

Metoda stuzy do awizowania podstawowe]j podpisanej przesytki ORLEN Paczka.

Parametry wywotania:

3.3.1 Wywotanie

<PartneriD>

identyfikator Klienta nadany
przez RUCH

(REQUIRED) 10 char

<PartnerKey>

hasto Klienta nadane przez RUCH

(REQUIRED) 10 char

<PhoneNumber>

numer telefonu odbiorcy

(REQUIRED) 9 char

<DestinationCode>

kod POPeR

(REQUIRED) 15 char

<AlternativeDestinationCode> alternatywny kod POPeR 15 char

<BoxSize> wielkos$¢ paczki (REQUIRED) 10 char
<PackValue> wartosc¢ przesytki (w groszach) 6 char
<CashOnDelivery> paczka za pobraniem (true/false) boolean
<AmountCashOnDelivery> kwota pobrania (w groszach) 6 char

<Insurance> ubezpieczenie paczki (true/false) boolean
<EMail> adres email odbiorcy 60 char
<FirstName> imie odbiorcy 30 char
<LastName> nazwisko odbiorcy 30 char
<CompanyName> firma odbiorcy 70 char
<StreetName> ulica z adresu odbiorcy 30 char
<BuildingNumber> numer budynku z adresu odbiorcy | 10 char

numer mieszkania z adresu

<FlatNumber> odbiorcy 10 char

<City> miasto z adresu odbiorcy 30 char
<PostCode> kod pocztowy z adresu odbiorcy 6 char

<SenderEMail>

adres email nadawcy

(REQUIRED) 60 char

<SenderFirstName>

imie nadawcy

(REQUIRED) 30 char

<SenderLastName> nazwisko nadawcy (REQUIRED) 30 char
<SenderCompanyName> firma nadawcy 70 char
<SenderStreetName> ulica z adresu nadawcy (REQUIRED) 30 char

numer budynku z adresu

<SenderBuildingNumber> nadawcy (REQUIRED) 10 char
numer mieszkania z adresu
<SenderFlatNumber> nadawcy 10 char

<SenderCity>

miasto z adresu nadawcy

(REQUIRED) 30 char

<SenderPostCode> kod pocztowy z adresu nadawcy | (REQUIRED) 6 char
<SenderPhoneNumber> numer telefonu nadawcy (REQUIRED) 9 char
<SenderOrders> nr zamdwienia nadawcy 30 char
<ReturnDestinationCode> kod POPeR do zwrotu 15 char
<ReturnEMail > adres email do zwrotu 60 char
<ReturnFirstName> imie osoby do zwrotu 30 char
<ReturnLastName> nazwisko osoby do zwrotu 30 char
<ReturnCompanyName> nazwa firm do zwrotu 70 char
<ReturnStreetName> ulica z adresu do zwrotu 30 char

numer budynku z adresu do
<ReturnBuildingNumber> zwrotu 10 char

numer mieszkania z adresu do
<ReturnFlatNumber> zwrotu 10 char
<ReturnCity> miasto z adresu do zwrotu 30 char
<ReturnPostCode> kod pocztowy z adresu do zwrotu | 6 char
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<ReturnPhoneNumber> numer telefonu do zwrotu 9 char

<ReturnPack> paczka zwrotna (T -jesli zwrotna) 1 char
tytut przelewu dla paczki za

<TransferDescription> pobraniem 70 char

<PrintAdress>

wybdr adresu do wydruku przy
zwrocie (1- adres nadania, 2 -
adres zwrotu)

(REQUIRED) 1 char

mozliwos¢ nadania paczki

<ReturnAvailable> zwrotnej (T -jesli tak) 1 char
<ReturnQuantity> liczba paczek zwrotnych 1 char
<AutoDestinationChange> string
<ConfirmTermsOfUse> potwierdz warunki uzytkowania string
potwierdz otrzymywanie
<ConfirmMarketing> materiatéw reklamowych string
<CofirmMailing> potwierdz adres email string

TransferDescription nie moze zawieraé polskich znakdow i specjalnych.

Pola <FirstName> i <LastName> sg obowigzkowe, jesli nie podano wartosci w polu <CompanyName>.

Pola <SenderFirstName> i <SenderLastName> sg obowigzkowe, jesli nie podano wartosci w polu

<SenderCompanyName>.

Pole <ReturnDestinationCode> wypetniane jest tyko w przypadku: nadania w PSD i wyborze innego

PSD do zwrotu niz PSD w ktérym paczka zostanie nadana.

Przy wyborze punktu odbioru APM oraz PKN, pole <BoxSize> jest obowigzkowe i przyjmuje wartosci: S,

M lub L.

Przyktad z minimalng wymagana lista pol:

<PartnerID>TESTO00001</PartnerID>

<PartnerKey>B87FDC41E2</PartnerKey>

<FirstName>ImieOdbiorcy</FirstName>

<LastName>NazwiskoOdbiorcy</LastName>

<PhoneNumber>111222333</PhoneNumber>

<DestinationCode>WS-116263-40-26</DestinationCode>

<PrintAdress>1</PrintAdress>

<SenderEMail>mail@mail.pl</SenderEMail>

<SenderFirstName>ImieNadawcy</SenderFirstName>

<SenderLastName>NazwiskoNadawcy</SenderLastName>

<SenderStreetName>Przyktadowa</SenderStreetName>

<SenderBuildingNumber>15</SenderBuildingNumber>
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<SenderCity>Warszawa</SenderCity>
<SenderPostCode>00-000</SenderPostCode>

<SenderPhoneNumber>123123123</SenderPhoneNumber>

3.31 Odpowiedz

Zwracane wartosci:

<Err> numer btedu

<ErrDes> opis btedu

<PackCode_RUCH> Numer EAN-13 przesytki

<DestinationCode> Kod POPER (potwierdzenie lub zmiana)

<Destinationld> Kod PSD

<PackPrice> Cena przesytki (w groszach)

<PackPaid> Optacenie przesytki (true/false)
Przyktad:

<Err>000</Err>

<ErrDes>saved</ErrDes>
<PackCode_RUCH>3400017433926</PackCode_RUCH>
<DestinationCode>WS-116263-27-26</DestinationCode>
<Destinationld>116263</Destinationld>
<PackPrice>849</PackPrice>

<PackPaid>true</PackPaid>

<NameCL>WARSZAWA</NameCL>

<NrCL>0130</NrCL>
<OriginDestinationCode>WS-116263-40-26</OriginDestinationCode>

<AutoChangeDestinationConfirm>0</AutoChangeDestinationConfirm>

3.4 GENERATELABELBUSINESSPACK

Metoda stuzy do awizowania przesytki ORLEN Paczka, w odpowiedzi zwraca etykiete w PDF.

341 Wywotanie

Parametry wywotania:

identyfikator Klienta nadany przez
<PartneriD> RUCH (REQUIRED) 10 char
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<PartnerKey>

hasto Klienta nadane przez RUCH

(REQUIRED) 10 char

<DestinationCode>

kod POPeR

(REQUIRED) 15 char

<AlternativeDestinationCode>

alternatywny kod POPeR

15 char

<BoxSize>

wielkos$¢ paczki

(REQUIRED) 10 char

<PackValue>

wartosé przesytki (w groszach)

6 char

<CashOnDelivery>

paczka za pobraniem

(true/false) boolean

<AmountCashOnDelivery>

kwota pobrania (w groszach)

6 char

<Insurance>

ubezpieczenie paczki

(true/false) boolean

<EMail> adres email odbiorcy 60 char
<FirstName> imie odbiorcy 30 char
<LastName> nazwisko odbiorcy 30 char
<CompanyName> firma odbiorcy 70 char
<StreetName> ulica z adresu odbiorcy 30 char
<BuildingNumber> numer budynku z adresu odbiorcy 10 char
<FlatNumber> numer mieszkania z adresu odbiorcy | 10 char

<City> miasto z adresu odbiorcy 30 char
<PostCode> kod pocztowy z adresu odbiorcy 6 char
<PhoneNumber> numer telefonu odbiorcy (REQUIRED) 9 char

<SenderEMail>

adres email nadawcy

(REQUIRED) 60 char

<SenderFirstName>

imie nadawcy

(REQUIRED) 30 char

<SenderLastName> nazwisko nadawcy (REQUIRED) 30 char
<SenderCompanyName> firma nadawcy 70 char
<SenderStreetName> ulica z adresu nadawcy (REQUIRED) 30 char

<SenderBuildingNumber>

numer budynku z adresu nadawcy

(REQUIRED) 10 char

<SenderFlatNumber>

numer mieszkania z adresu nadawcy

10 char

<SenderCity> miasto z adresu nadawcy (REQUIRED) 30 char
<SenderPostCode> kod pocztowy z adresu nadawcy (REQUIRED) 6 char
<SenderPhoneNumber> numer telefonu nadawcy (REQUIRED) 9 char
<SenderOrders> nr zaméwienia nadawcy 30 char
<ReturnDestinationCode> kod POPeR do zwrotu 15 char
<ReturnEMail > adres email do zwrotu 60 char
<ReturnFirstName> imie osoby do zwrotu 30 char
<ReturnLastName> nazwisko osoby do zwrotu 30 char
<ReturnCompanyName> nazwa firm do zwrotu 70 char
<ReturnStreetName> ulica z adresu do zwrotu 30 char
<ReturnBuildingNumber> numer budynku z adresu do zwrotu 10 char

numer mieszkania z adresu do
<ReturnFlatNumber> zwrotu 10 char
<ReturnCity> miasto z adresu do zwrotu 30 char
<ReturnPostCode> kod pocztowy z adresu do zwrotu 6 char
<ReturnPhoneNumber> numer telefonu do zwrotu 9 char
<ReturnPack> paczka zwrotna (T -jesli zwrotna) 1 char

tytut przelewu dla paczki za
<TransferDescription> pobraniem 70 char

<PrintAdress>

wybdr adresu do wydruku przy
zwrocie (1- adres nadania, 2 - adres
zwrotu)

(REQUIRED) 1 char

<ReturnAvailable>

mozliwos$¢ nadania paczki zwrotne;j
(T -jesli tak)

1 char

<ReturnQuantity>

liczba paczek zwrotnych

1 char

<PrintType>

wybor etykiety do wydruku (1-
petny adres, 2- adres anonimowy)

(REQUIRED) 1 char
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TransferDescription nie moze zawieraé polskich znakdéw i specjalnych.
Pola <FirstName> i <LastName> sg obowigzkowe, chyba, ze podano wartos¢ w polu <CompanyName>.

Pola <SenderFirstName> i <SenderLastName> sg obowigzkowe, jesli nie podano wartos¢ w polu
<SenderCompanyName>.

Pole <ReturnDestinationCode> wypetniane jest tyko w przypadku: nadania w PSD i wyborze innego
PSD do zwrotu niz PSD w ktérym paczka zostanie nadana.

Przy wyborze punktu odbioru APM oraz PKN, pole <BoxSize> jest obowigzkowe i przyjmuje wartosci: S,
M lub L.

Przyktad z minimalng wymagana lista pol:
<PartnerID>1234567890</Partner|D>
<PartnerKey>XAGWEGWw12</PartnerKey>
<DestinationCode>0130-6556-40-43</DestinationCode>
<FirstName>Jan</FirstName>
<LastName>Nowak</LastName>
<PhoneNumber>123456789</PhoneNumber>
<SenderEMail>test@tt.pl</SenderEMail>
<SenderCompanyName>Firma SA</SenderCompanyName>
<SenderStreetName>Prosta</SenderStreetName>
<SenderBuildingNumber>1234</SenderBuildingNumber>
<SenderCity>Warszawa</SenderCity>
<SenderPostCode>99-999</SenderPostCode>
<SenderPhoneNumber>123456789</SenderPhoneNumber>
<PrintAdress>1</PrintAdress>

<PrintType>1</PrintType>

3.4.2 Odpowiedz

PDF jest zwracany w Web.serwis jako output parametr.

Zwracane wartosci:
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<Err> Numer btedu
<ErrDes> Opis btedu
<PackCode_RUCH> Numer EAN-13 przesytki
<DestinationCode> Kod POPER (potwierdzenie lub zmiana)
<Destinationld> Kod PSD
<PackPrice> Cena przesytki (w groszach)
<PackPaid> Optacenie przesytki true/false
<LabelData> Etykieta PDF (Base 64)

Przyktad:

<Err>000</Err>

<ErrDes>saved</ErrDes>
<PackCode_RUCH>2900000000230</PackCode_RUCH>
<DestinationCode>0130-6556-40-43</DestinationCode>
<Destinationld>123680</Destinationld>
<PackPrice>745</PackPrice>
<PackPaid>false</PackPaid>

<LabelData>base64</LabelData>

Przyktadowy kod c# z wywotaniem Web serwisu:
PwR.WebServicePwRTest service = new PwR.WebServicePwRTest();
service.UseDefaultCredentials = true;
byte[] data;

service.GeneratelLabelBusinessPack("<user>", "<password>", "<destination code>", null, null, null, null,
null, null, null, "<first name>","last name",

"<company>", "<address>", "<number>", null, "<city>", "<postal code>", "<phone>", "<email>",
null, null, "<sender company>", "<adress>", "number", null, "<city>", "<postal code>",
"<sender phone>", null, null, null, null, null, null, null, null, null, null, null, null, null, null, "1", null,
null, "1", out data);

if (data !=null)

{

File.WriteAllBytes("c:\\Paczka_test\\label.pdf", data);}
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3.5 GENERATELABELBUSINESSPACKALLEGRO

Metoda stuzy do awizowania przesytki Allegro, w odpowiedzi zwraca etykiete w PDF.

Parametry wywotania:

3.51 Wywotanie

<PartneriD>

identyfikator Klienta nadany
przez RUCH

(REQUIRED) 10 char

<PartnerKey>

hasto Klienta nadane przez RUCH

(REQUIRED) 10 char

<DestinationCode>

kod POPeR

(REQUIRED) 15 char

<AlternativeDestinationCode> alternatywny kod POPeR 15 char
<BoxSize> wielkos$¢ paczki (REQUIRED) 10 char
<PackValue> wartosc¢ przesytki (w groszach) 6 char
<CashOnDelivery> paczka za pobraniem (true/false) boolean
<AmountCashOnDelivery> kwota pobrania (w groszach) 6 char
<Insurance> ubezpieczenie paczki (true/false) boolean
<EMail> adres email odbiorcy 60 char
<FirstName> imie odbiorcy 30 char
<LastName> nazwisko odbiorcy 30 char
<CompanyName> firma odbiorcy 70 char
<StreetName> ulica z adresu odbiorcy 30 char
<BuildingNumber> numer budynku z adresu odbiorcy | 10 char

numer mieszkania z adresu
<FlatNumber> odbiorcy 10 char
<City> miasto z adresu odbiorcy 30 char
<PostCode> kod pocztowy z adresu odbiorcy 6 char
<PhoneNumber> numer telefonu odbiorcy (REQUIRED) 9 char

<SenderEMail>

adres email nadawcy

(REQUIRED) 60 char

<SenderFirstName>

imie nadawcy

(REQUIRED) 30 char

<SenderLastName> nazwisko nadawcy (REQUIRED) 30 char
<SenderCompanyName> firma nadawcy 70 char
<SenderStreetName> ulica z adresu nadawcy (REQUIRED) 30 char

numer budynku z adresu

<SenderBuildingNumber> nadawcy (REQUIRED) 10 char
numer mieszkania z adresu
<SenderFlatNumber> nadawcy 10 char

<SenderCity>

miasto z adresu nadawcy

(REQUIRED) 30 char

<SenderPostCode> kod pocztowy z adresu nadawcy | (REQUIRED) 6 char
<SenderPhoneNumber> numer telefonu nadawcy (REQUIRED) 9 char
<SenderOrders> nr zamowienia nadawcy 30 char
<ReturnDestinationCode> kod POPeR do zwrotu 15 char
<ReturnEMail > adres email do zwrotu 60 char
<ReturnFirstName> imie osoby do zwrotu 30 char
<ReturnLastName> nazwisko osoby do zwrotu 30 char
<ReturnCompanyName> nazwa firm do zwrotu 70 char
<ReturnStreetName> ulica z adresu do zwrotu 30 char

numer budynku z adresu do
<ReturnBuildingNumber> zwrotu 10 char

numer mieszkania z adresu do
<ReturnFlatNumber> zwrotu 10 char
<ReturnCity> miasto z adresu do zwrotu 30 char
<ReturnPostCode> kod pocztowy z adresu do zwrotu | 6 char
<ReturnPhoneNumber> numer telefonu do zwrotu 9 char
<ReturnPack> paczka zwrotna (T -jesli zwrotna) 1 char
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tytut przelewu dla paczki za
<TransferDescription> pobraniem 70 char
wybdr adresu do wydruku przy
zwrocie (1- adres nadania, 2 -

<PrintAdress> adres zwrotu) (REQUIRED) 1 char
mozliwos¢ nadania paczki

<ReturnAvailable> zwrotnej (T -jesli tak) 1 char

<ReturnQuantity> liczba paczek zwrotnych 1 char

wybdr etykiety do wydruku (1-
petny adres, 2- adres

<PrintType> anonimowy) (REQUIRED) 1 char
<Allegrold> identyfikator klienta Allegro 50 char
<AllegroOrderld> Identyfikator zamoéwienia Allegro | 50 char
<AllegroCustomerLogin> login klienta Allegro 50 char
<Allegro Transactionld> Identyfikator transkacji Allegro 50 char
<AllegroSellerld> Identyfikator sprzedawcy Allegro 50 char

Rodzaj dostawy Allegro (mozliwe

warianty:

Allegro ORLEN Paczka 10007,
Allegro ORLEN Paczka pobranie

<AllegroDeliveryType> 20007) 50 char
<AllegroPaymentType> Rodzaj ptatnosci Allegro 50 char
<AllegroDealld> Identyfikator umowy Allegro 50 char

3.5.2 Przykiad wywotania

Przyktad wywotania:

<BusinessPackAllegro>
<PartnerID>TEST000601</PartnerID>
<PartnerKey>B87FDC41E2</PartnerKey>
<DestinationCode>WS-116263-40-26</DestinationCode>
<AlternativeDestinationCode></AlternativeDestinationCode>
<BoxSize></BoxSize>
<PackValue>899</PackValue>
<CashOnDelivery></CashOnDelivery>
<AmountCashOnDelivery></AmountCashOnDelivery>
<Insurance></Insurance>
<EMail>test@mail.com</EMail>
<FirstName>Zenon</FirstName>
<LastName>Zenonowicz</LastName>
<CompanyName></CompanyName>
<StreetName>Testowinska</StreetName>
<BuildingNumber>7</BuildingNumber>
<FlatNumber></FlatNumber>
<City>Warszawa</City>
<PostCode>00-000</PostCode>
<PhoneNumber>111555899</PhoneNumber>
<SenderEMail>nadawca@test.com</SenderEMail>
<SenderFirstName>Nadya</SenderFirstName>
<SenderLastName>lvanovich</SenderLastName>
<SenderCompanyName></SenderCompanyName>
<SenderStreetName>Stalowa</SenderStreetName>
<SenderBuildingNumber>89</SenderBuildingNumber>
<SenderFlatNumber></SenderFlatNumber>
<SenderCity>Warszawa</SenderCity>
<SenderPostCode>00-001</SenderPostCode>
<SenderPhoneNumber>999666333</SenderPhoneNumber>
<SenderOrders></SenderOrders>
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<ReturnDestinationCode></ReturnDestinationCode>
<ReturnEMail></ReturnEMail>
<ReturnFirstName></ReturnFirstName>
<ReturnLastName></ReturnLastName>
<ReturnCompanyName></ReturnCompanyName>
<ReturnStreetName></ReturnStreetName>
<ReturnBuildingNumber></ReturnBuildingNumber>
<ReturnFlatNumber></ReturnFlatNumber>
<ReturnCity></ReturnCity>
<ReturnPostCode></ReturnPostCode>
<ReturnPhoneNumber></ReturnPhoneNumber>
<ReturnPack></ReturnPack>
<TransferDescription></TransferDescription>
<PrintAdress>1</PrintAdress>
<ReturnAvailable></ReturnAvailable>
<ReturnQuantity></ReturnQuantity>
<PrintType>1</PrintType>
<Allegrold>123456</Allegrold>
<AllegroOrderld>123457</AllegroOrderld>
<AllegroCustomerLogin>765432</AllegroCustomerLogin>
<AllegroTransactionld></AllegroTransactionld>
<AllegroSellerld>8978980</AllegroSellerid>
<AllegroDeliveryType>100007</AllegroDeliveryType>
<AllegroPaymentType>Przy odbiorze (za pobraniem)</AllegroPaymentType>
<AllegroDealld></AllegroDealld>
</BusinessPackAllegro>

Zwracane wartosci:

<Err>

<ErrDes>
<PackCode_RUCH>
<DestinationCode>
<Destinationld>
<PackPrice>
<PackPaid>
<NameCL>

<NrCL>

3.5.3 Odpowiedz

Numer btedu

Opis btedu

Numer EAN-13 przesyiki

Kod POPeR kiosku docelowego
Identyfikator kiosku docelowego
Cena przesytki (w groszach)
Optacenie przesytki true/false
Nazwa regionu kiosku docelowego
Kod regionu kiosku docelowego

<OriginDestinationCode> Kod POPeR kiosku nadania
<AutoChangeDestinationConfirm> 0 lub 1

<LabelData>

Przyktad odpowiedazi:

<GeneratelabelBusinessPack>
<Err>000</Err>

Etykieta PDF (Base 64)

<ErrDes>saved</ErrDes>
<PackCode_RUCH>3400017456048</PackCode_RUCH>
<DestinationCode>WS-116263-40-26</DestinationCode>
<Destinationld>116263</Destinationld>

<PackPrice>849</PackPrice>

<PackPaid>true</PackPaid>

<NameCL>WARSZAWA</NameCL>

<NrCL>0130</NrCL>
<OriginDestinationCode>WS-116263-40-26</0riginDestinationCode>
<AutoChangeDestinationConfirm>0</AutoChangeDestinationConfirm>

</GeneratelLabelBusinessPack>
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3.6 GENERATELABELBUSINESSPACKLIST

Metoda stuzy do awizowania listy przesytek ORLEN Paczka, w odpowiedzi zwraca etykiete w PDF.

Maksymalna ilos¢ jednorazowo zwréconych etykiet wynosi 50.

Parametry wywotania:

3.6.1 Wywotanie

<PartneriD>

identyfikator Klienta nadany
przez RUCH

(REQUIRED) 10 char

<PartnerKey>

hasto Klienta nadane przez RUCH

(REQUIRED) 10 char

<Format>

format etykiety (PDF lub EPL)

(REQUIRED) 3 char

BusinessPackList

struktura ,,BusinessPack” do listy
paczek

(REQUIRED) (ilo§¢ 1 ... n)

BusinessPack struktura

<DestinationCode> kod POPeR (REQUIRED) 15 char
<AlternativeDestinationCode> alternatywny kod POPeR 15 char
<ReturnDestinationCode> kod POPeR do zwrotu 15 char
<BoxSize> wielkos$¢ paczki (REQUIRED) 10 char
<PackValue> wartos¢ przesytki (w groszach) 6 char
<CashOnDelivery> paczka za pobraniem (true/false) boolean
<AmountCashOnDelivery> kwota pobrania (w groszach) 6 char
<Insurance> ubezpieczenie paczki (true/false) boolean
<EMail> adres email odbiorcy 60 char
<FirstName> imie odbiorcy 30 char
<LastName> nazwisko odbiorcy 30 char
<CompanyName> firma odbiorcy 70 char
<StreetName> ulica z adresu odbiorcy 30 char
<BuildingNumber> numer budynku z adresu odbiorcy | 10 char

numer mieszkania z adresu
<FlatNumber> odbiorcy 10 char
<City> miasto z adresu odbiorcy 30 char
<PostCode> kod pocztowy z adresu odbiorcy 6 char
<PhoneNumber> numer telefonu odbiorcy (REQUIRED) 9 char

<SenderEMail>

adres email nadawcy

(REQUIRED) 60 char

<SenderFirstName>

imie nadawcy

(REQUIRED) 30 char

<SenderLastName> nazwisko nadawcy (REQUIRED) 30 char
<SenderCompanyName> firma nadawcy 70 char
<SenderStreetName> ulica z adresu nadawcy (REQUIRED) 30 char

numer budynku z adresu

<SenderBuildingNumber> nadawcy (REQUIRED) 10 char
numer mieszkania z adresu
<SenderFlatNumber> nadawcy 10 char

<SenderCity> miasto z adresu nadawcy (REQUIRED) 30 char
<SenderPostCode> kod pocztowy z adresu nadawcy | (REQUIRED) 6 char
<SenderPhoneNumber> numer telefonu nadawcy (REQUIRED) 9 char
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<SenderOrders> nr zamowienia nadawcy 30 char
<ReturnEMail > adres email do zwrotu 60 char
<ReturnFirstName> imie osoby do zwrotu 30 char
<ReturnLastName> nazwisko osoby do zwrotu 30 char
<ReturnCompanyName> nazwa firm do zwrotu 70 char
<ReturnStreetName> ulica z adresu do zwrotu 30 char
numer budynku z adresu do
<ReturnBuildingNumber> zwrotu 10 char
numer mieszkania z adresu do
<ReturnFlatNumber> zwrotu 10 char
<ReturnCity> miasto z adresu do zwrotu 30 char
<ReturnPostCode> kod pocztowy z adresu do zwrotu | 6 char
<ReturnPhoneNumber> numer telefonu do zwrotu 9 char
<ReturnPack> paczka zwrotna (T -jesli zwrotna) 1 char

<PrintAdress>

wybér adresu do wydruku przy
zwrocie (1- adres nadania, 2 -
adres zwrotu)

(REQUIRED) 1 char

wybor etykiety do wydruku (1-
petny adres, 2- adres

<PrintType> anonimowy) (REQUIRED) 1 char
tytut przelewu dla paczki za
<TransferDescription> pobraniem 70 char
mozliwos¢ nadania paczki
<ReturnAvailable> zwrotnej (T -jesli tak) 1 char
<ReturnQuantity> liczba paczek zwrotnych 1 char

TransferDescription nie moze zawieraé polskich znakdéw i specjalnych.

Pola <FirstName> i <LastName> sg obowigzkowe, chyba, ze podano wartos$é w polu <CompanyName>.

Pola <SenderFirstName> i <SenderLastName> sg obowigzkowe, jesli nie podano wartos¢ w polu

<SenderCompanyName>.

Pole <ReturnDestinationCode> wypetniane jest tyko w przypadku: nadania w PSD i wyborze innego

PSD do zwrotu niz PSD w ktérym paczka zostanie nadana.

Przy wyborze punktu odbioru APM oraz PKN, pole <BoxSize> jest obowigzkowe i przyjmuje wartosci: S,

M lub L.

Przyktad z minimalng wymagana listg pol:

<PartnerID>1234567890</PartnerID>

<PartnerKey>XAGWEGWw12</PartnerKey>

<Format>PDF</Format>

<BusinessPackList>

<BusinessPack>

<DestinationCode>0130-6556-40-43</DestinationCode>
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<FirstName>Jan</FirstName>
<LastName>Nowak</LastName>
<PhoneNumber>123456789</PhoneNumber>
<SenderEMail>test@tt.pl</SenderEMail>
<SenderCompanyName>Firma SA</SenderCompanyName>
<SenderStreetName>Prosta</SenderStreetName>
<SenderBuildingNumber>1234</SenderBuildingNumber>
<SenderCity>Warszawa</SenderCity>
<SenderPostCode>99-999</SenderPostCode>
<SenderPhoneNumber>123456789</SenderPhoneNumber>
<SenderOrders>1</ SenderOrders>
<PrintAdress>1</PrintAdress>

<PrintType>1</PrintType>

</BusinessPack>

</BusinessPackList>

3.6.2 Odpowiedz

PDF jest zwracany w Web.serwis jako output parameter.

Zwracane wartosci:

<GeneratelabelBusinessPackList> - lista paczek (1 ... n)

<Err>

Numer btedu

<ErrDes>

Opis btedu

<PackCode_RUCH>

Numer EAN-13 przesytki

<DestinationCode>

Kod POPER (potwierdzenie lub zmiana)

<Destinationld>

Kod PSD

<PackPrice>

Cena przesytki (w groszach)

<PackPaid>

Optacenie przesytki true/false

< SenderOrders>

Numer zamodwienia nadawcy

<GeneratelabelBusinessPackList>

<LabelData>

Etykieta PDF (Base 64)
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Przyktad:

< GeneratelabelBusinessPackList>

<Err>000</Err>

<ErrDes>saved</ErrDes>

<PackCode_RUCH>2900000000230</PackCode_RUCH>

<DestinationCode>0130-6556-40-43</DestinationCode>

<Destinationld>123680</Destinationld>

<PackPrice>745</PackPrice>

<PackPaid>false</PackPaid>

<SenderOrders>2</SenderOrders>

</GeneratelLabelBusinessPackList>

<LabelData>base64</LabelData>

3.7 GENERATELABELBUSINESSPACKLISTALLEGRO

Metoda stuzy do generowania list przesytek Allegro. Zwraca liste BusinessPackList z elementami

BusinessPackAllegro.

Parametry wywotania:

3.7.1  Wywotanie

<PartneriD>

identyfikator Klienta nadany
przez RUCH

(REQUIRED) 10 char

<PartnerKey>

hasto Klienta nadane przez RUCH

(REQUIRED) 10 char

<Format>

format etykiety (PDF lub EPL lub
PDF10 lub ZPL)

(REQUIRED) 3 char

BusinessPackListAllegro

struktura ,,BusinessPackAllegro”
do listy paczek

(REQUIRED) (ilo$¢ 1 ... n)

BusinessPackAllegro struktura

<PartneriD>

identyfikator Klienta nadany
przez RUCH

(REQUIRED) 10 char

<PartnerKey>

hasto Klienta nadane przez RUCH

(REQUIRED) 10 char

<DestinationCode>

kod POPeR

(REQUIRED) 15 char

<AlternativeDestinationCode> alternatywny kod POPeR 15 char

<BoxSize> wielkos$¢ paczki (REQUIRED) 10 char
<PackValue> wartos¢ przesytki (w groszach) 6 char
<CashOnDelivery> paczka za pobraniem (true/false) boolean
<AmountCashOnDelivery> kwota pobrania (w groszach) 6 char

<Insurance> ubezpieczenie paczki (true/false) boolean
<EMail> adres email odbiorcy 60 char
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<FirstName> imie odbiorcy 30 char
<LastName> nazwisko odbiorcy 30 char
<CompanyName> firma odbiorcy 70 char
<StreetName> ulica z adresu odbiorcy 30 char
<BuildingNumber> numer budynku z adresu odbiorcy | 10 char
numer mieszkania z adresu

<FlatNumber> odbiorcy 10 char

<City> miasto z adresu odbiorcy 30 char
<PostCode> kod pocztowy z adresu odbiorcy 6 char
<PhoneNumber> numer telefonu odbiorcy (REQUIRED) 9 char

<SenderEMail>

adres email nadawcy

(REQUIRED) 60 char

<SenderFirstName>

imie nadawcy

(REQUIRED) 30 char

<SenderLastName> nazwisko nadawcy (REQUIRED) 30 char
<SenderCompanyName> firma nadawcy 70 char
<SenderStreetName> ulica z adresu nadawcy (REQUIRED) 30 char

numer budynku z adresu

<SenderBuildingNumber> nadawcy (REQUIRED) 10 char
numer mieszkania z adresu
<SenderFlatNumber> nadawcy 10 char

<SenderCity>

miasto z adresu nadawcy

(REQUIRED) 30 char

<SenderPostCode> kod pocztowy z adresu nadawcy | (REQUIRED) 6 char
<SenderPhoneNumber> numer telefonu nadawcy (REQUIRED) 9 char
<SenderOrders> nr zamowienia nadawcy 30 char
<ReturnDestinationCode> kod POPeR do zwrotu 15 char
<ReturnEMail > adres email do zwrotu 60 char
<ReturnFirstName> imie osoby do zwrotu 30 char
<ReturnLastName> nazwisko osoby do zwrotu 30 char
<ReturnCompanyName> nazwa firm do zwrotu 70 char
<ReturnStreetName> ulica z adresu do zwrotu 30 char

numer budynku z adresu do
<ReturnBuildingNumber> zwrotu 10 char

numer mieszkania z adresu do
<ReturnFlatNumber> zwrotu 10 char
<ReturnCity> miasto z adresu do zwrotu 30 char
<ReturnPostCode> kod pocztowy z adresu do zwrotu | 6 char
<ReturnPhoneNumber> numer telefonu do zwrotu 9 char
<ReturnPack> paczka zwrotna (T -jesli zwrotna) 1 char

tytut przelewu dla paczki za
<TransferDescription> pobraniem 70 char

<PrintAdress>

wybdr adresu do wydruku przy
zwrocie (1- adres nadania, 2 -
adres zwrotu)

(REQUIRED) 1 char

<ReturnAvailable>

mozliwos¢ nadania paczki
zwrotnej (T -jesli tak)

1 char

Przyktad wywotania:

<GeneratelabelBusinessPackListAllegro xmlns="https://api-test.paczkawruchu.pl/WebServicePwRTest">

<PartnerID>TEST000601</PartneriD>

<PartnerKey>B87FDC41E2</PartnerKey>
<AutoDestinationChange></AutoDestinationChange>

<Format>PDF</Format>
<BusinessPackList>
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<BusinessPackAllegro>
<DestinationCode>WS-116263-40-26</DestinationCode>
<AlternativeDestinationCode></AlternativeDestinationCode>
<BoxSize></BoxSize>

<PackValue>899</PackValue>
<CashOnDelivery></CashOnDelivery>
<AmountCashOnDelivery></AmountCashOnDelivery>
<Insurance></Insurance>
<EMail>test@mail.com</EMail>
<FirstName>Zenon</FirstName>
<LastName>Zenonowicz</LastName>
<CompanyName></CompanyName>
<StreetName>Testowinska</StreetName>
<BuildingNumber>7</BuildingNumber>
<FlatNumber></FlatNumber>

<City>Warszawa</City>
<PostCode>00-000</PostCode>
<PhoneNumber>111555899</PhoneNumber>
<SenderEMail>nadawca@test.com</SenderEMail>
<SenderFirstName>Nadya</SenderFirstName>
<SenderLastName>lvanovich</SenderLastName>
<SenderCompanyName></SenderCompanyName>
<SenderStreetName>Stalowa</SenderStreetName>
<SenderBuildingNumber>89</SenderBuildingNumber>
<SenderFlatNumber></SenderFlatNumber>
<SenderCity>Warszawa</SenderCity>
<SenderPostCode>00-001</SenderPostCode>
<SenderPhoneNumber>999666333</SenderPhoneNumber>
<SenderOrders></SenderOrders>
<ReturnDestinationCode></ReturnDestinationCode>
<ReturnEMail></ReturnEMail>
<ReturnFirstName></ReturnFirstName>
<ReturnLastName></ReturnLastName>
<ReturnCompanyName></ReturnCompanyName>
<ReturnStreetName></ReturnStreetName>
<ReturnBuildingNumber></ReturnBuildingNumber>
<ReturnFlatNumber></ReturnFlatNumber>
<ReturnCity></ReturnCity>
<ReturnPostCode></ReturnPostCode>
<ReturnPhoneNumber></ReturnPhoneNumber>
<ReturnPack></ReturnPack>
<TransferDescription></TransferDescription>
<PrintAdress>1</PrintAdress>
<ReturnAvailable></ReturnAvailable>
<ReturnQuantity></ReturnQuantity>
<PrintType>1</PrintType>
<Allegrold>123456</Allegrold>
<AllegroOrderld>123457</AllegroOrderld>
<AllegroCustomerlLogin>765432</AllegroCustomerLogin>
<AllegroTransactionld></AllegroTransactionld>
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<AllegroSellerld>8978980</AllegroSellerid>
<AllegroDeliveryType>100007</AllegroDeliveryType>
<AllegroPaymentType>Przy odbiorze (za pobraniem)</AllegroPaymentType>
<AllegroDealld></AllegroDealld>

</BusinessPackAllegro>

<BusinessPackAllegro>

</BusinessPackAllegro>
</BusinessPackList>
</GeneratelLabelBusinessPackListAllegro>

3.7.2 Odpowiedz

Zwrocony jest PDF z etykietami:

<GeneratelabelBusinessPackListAllegro> ; lista paczek (1 ... n)
<Err> numer btedu

<ErrDes> opis btedu

<PackCode_RUCH> 13 cyfrowy kod paczki
<DestinationCode> Kod POPER docelowego kiosku
<DestinationID> Kod PSD docelowego kiosku
<PackPrice> cena paczki(w groszach)

<PackPaid> czy paczka optacona (true/false)
<NameCL> nazwa regionu kiosku docelowego

<NrCL> numer regionu kioski docelowego
<OriginDestinationCode>Kod POPeR kiosku nadajgcego
<AutoChangeDestinationConfirm> 0 lub 1
</GeneratelabelBusinessPackList>

<LabelData> Etykieta PDF

Przyktad odpowiedazi:

<GeneratelabelBusinessPackList diffgr:id="GeneratelLabelBusinessPackList1"
msdata:rowOrder="0">
<Err>000</Err>
<ErrDes>saved</ErrDes>
<PackCode_RUCH>3400017456079</PackCode_RUCH>
<DestinationCode>WS-116263-40-26</DestinationCode>
<Destinationld>116263</Destinationld>
<PackPrice>849</PackPrice>
<PackPaid>true</PackPaid>
<NameCL>WARSZAWA</NameCL>
<NrCL>0130</NrCL>
<OriginDestinationCode>WS-116263-40-26</0riginDestinationCode>
<AutoChangeDestinationConfirm>0</AutoChangeDestinationConfirm>
</GeneratelabelBusinessPackList>
<GeneratelabelBusinessPackList diffgr:id="GeneratelLabelBusinessPackList2"
msdata:rowOrder="1">
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</GeneratelLabelBusinessPackList>

3.8 GENERATELABELBUSINESSPACKLISTTWO

Metoda stuzy do awizowania listy przesytek ORLEN Paczka, w odpowiedzi zwraca etykiete w PDF.

Parametry wywotania:

3.8.1  Wywotanie

<PartneriD>

identyfikator Klienta nadany
przez RUCH

(REQUIRED) 10 char

<PartnerKey>

hasto Klienta nadane przez RUCH

(REQUIRED) 10 char

<AutoDestinationChange>

string

<Format>

format etykiety (PDF lub EPL lub
PDF10 lub ZPL)

(REQUIRED) 5 char

BusinessPackList

struktura ,,BusinessPack” do listy
paczek

(REQUIRED) (ilo$¢ 1 ... n)

BusinessPack struktura

<DestinationCode> kod POPeR (REQUIRED) 15 char
<AlternativeDestinationCode> alternatywny kod POPeR 15 char
<BoxSize> wielkos$¢ paczki (REQUIRED) 10 char
<PackValue> wartosc¢ przesytki (w groszach) 6 char
<CashOnDelivery> paczka za pobraniem (true/false) boolean
<AmountCashOnDelivery> kwota pobrania (w groszach) 6 char
<Insurance> ubezpieczenie paczki (true/false) boolean
<EMail> adres email odbiorcy 60 char
<FirstName> imie odbiorcy 30 char
<LastName> nazwisko odbiorcy 30 char
<CompanyName> firma odbiorcy 70 char
<StreetName> ulica z adresu odbiorcy 30 char
<BuildingNumber> numer budynku z adresu odbiorcy | 10 char

numer mieszkania z adresu
<FlatNumber> odbiorcy 10 char
<City> miasto z adresu odbiorcy 30 char
<PostCode> kod pocztowy z adresu odbiorcy 6 char
<PhoneNumber> numer telefonu odbiorcy (REQUIRED) 9 char

<SenderEMail>

adres email nadawcy

(REQUIRED) 60 char

<SenderFirstName>

imie nadawcy

(REQUIRED) 30 char

<SenderLastName> nazwisko nadawcy (REQUIRED) 30 char
<SenderCompanyName> firma nadawcy 70 char
<SenderStreetName> ulica z adresu nadawcy (REQUIRED) 30 char

numer budynku z adresu

<SenderBuildingNumber> nadawcy (REQUIRED) 10 char
numer mieszkania z adresu
<SenderFlatNumber> nadawcy 10 char

<SenderCity> miasto z adresu nadawcy (REQUIRED) 30 char
<SenderPostCode> kod pocztowy z adresu nadawcy | (REQUIRED) 6 char
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<SenderPhoneNumber> numer telefonu nadawcy (REQUIRED) 9 char
<SenderOrders> nr zamowienia nadawcy 30 char
<ReturnDestinationCode> kod POPeR do zwrotu 15 char
<ReturnEMail > adres email do zwrotu 60 char
<ReturnFirstName> imie osoby do zwrotu 30 char
<ReturnLastName> nazwisko osoby do zwrotu 30 char
<ReturnCompanyName> nazwa firm do zwrotu 70 char
<ReturnStreetName> ulica z adresu do zwrotu 30 char

numer budynku z adresu do
<ReturnBuildingNumber> zwrotu 10 char

numer mieszkania z adresu do
<ReturnFlatNumber> zwrotu 10 char
<ReturnCity> miasto z adresu do zwrotu 30 char
<ReturnPostCode> kod pocztowy z adresu do zwrotu | 6 char
<ReturnPhoneNumber> numer telefonu do zwrotu 9 char
<ReturnPack> paczka zwrotna (T -jesli zwrotna) 1 char

tytut przelewu dla paczki za
<TransferDescription> pobraniem 70 char

wybdr adresu do wydruku przy

zwrocie (1- adres nadania, 2 -
<PrintAdress> adres zwrotu) (REQUIRED) 1 char

mozliwos¢ nadania paczki
<ReturnAvailable> zwrotnej (T -jesli tak) 1 char
<ReturnQuantity> liczba paczek zwrotnych 1 char

wybor etykiety do wydruku (1-

petny adres, 2- adres
<PrintType> anonimowy) (REQUIRED) 1 char

TransferDescription nie moze zawieraé polskich znakdéw i specjalnych.

Pola <FirstName> i <LastName> sg obowigzkowe, chyba, ze podano wartos$é¢ w polu <CompanyName>.

Pola <SenderFirstName> i <SenderLastName> sg obowigzkowe, jesli nie podano wartos¢ w polu

<SenderCompanyName>.

Pole <ReturnDestinationCode> wypetniane jest tyko w przypadku: nadania w PSD i wyborze innego

PSD do zwrotu niz PSD w ktérym paczka zostanie nadana.

Przy wyborze punktu odbioru APM oraz PKN, pole <BoxSize> jest obowigzkowe i przyjmuje wartosci: S,

M lub L.

Przyktad z minimalng wymagana listg pol:
<PartnerID>1234567890</Partner|D>
<PartnerKey>XAGWEGWw12</PartnerKey>
<Format>PDF</Format>
<BusinessPackList>

<BusinessPack>
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<DestinationCode>WS-116263-40-26</DestinationCode>
<BoxSize></BoxSize>

<PackValue>899</PackValue>
<EMail>test@mail.com</EMail>
<FirstName>Zenon</FirstName>
<LastName>Zenonowicz</LastName>
<CompanyName></CompanyName>
<StreetName>Testowinska</StreetName>
<BuildingNumber>7</BuildingNumber>
<City>Warszawa</City>
<PostCode>00-000</PostCode>
<PhoneNumber>111555899</PhoneNumber>
<SenderEMail>nadawca@test.com</SenderEMail>
<SenderFirstName>Nadya</SenderFirstName>
<SenderLastName>lvanovich</SenderLastName>
<SenderStreetName>Stalowa</SenderStreetName>
<SenderBuildingNumber>89</SenderBuildingNumber>
<SenderPostCode>00-001</SenderPostCode>
<SenderPhoneNumber>999666333</SenderPhoneNumber>
<PrintAdress>1</PrintAdress>
<PrintType>1</PrintType>

</BusinessPack>

</BusinesPackList>

3.8.2 Odpowiedz

PDF jest zwracany w Web.serwis jako output parameter.
Zwracane wartosci:

<GeneratelabelBusinessPackList> - lista paczek (1 ... n)
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<Err> Numer btedu

<ErrDes> Opis btedu

<PackCode_RUCH> Kod paczki

<DestinationCode> Kod POPeR kiosku docelowego
<DestinationID> Kod PSD

<PackPrice>

Cena paczki w groszach

<PackPaid>

Czy paczka jest optacona

<ReturnDestinationld>

Kod PSD kiosku zwrotu

<ReturnDestinationCode>

Kod POPeR kiosku zwrotu

<NameCL>

Numer

<NrCL>

Kod regionu kiosku docelowego

<OriginDestinationCode>

Kod POPeR kiosku nadania

<AutoChangeDestinationConfirm>

Olub1

Przyktad:

<Err>000</Err>

<ErrDes>saved</ErrDes>
<PackCode_RUCH>3400017461509</PackCode_RUCH>
<DestinationCode>WS-116263-40-26</DestinationCode>
<Destinationld>116263</Destinationld>
<PackPrice>849</PackPrice>

<PackPaid>true</PackPaid>

<NameCL>WARSZAWA</NameCL>

<NrCL>0130</NrCL>
<OriginDestinationCode>WS-116263-40-26</0riginDestinationCode>

<AutoChangeDestinationConfirm>0</AutoChangeDestinationConfirm>

3.9 GENERATELABELBUSINESSPACKTWO

Metoda stuzy do awizowania przesytki ORLEN Paczka, w odpowiedzi zwraca etykiete w PDF.

Parametry wywotania:

3.9.1 Wywotanie

<PartneriD>

identyfikator Klienta nadany
przez RUCH

(REQUIRED) 10 char

<PartnerKey>

hasto Klienta nadane przez RUCH

(REQUIRED) 10 char

<DestinationCode>

kod POPeR

(REQUIRED) 15 char

<AlternativeDestinationCode>

alternatywny kod POPeR

15 char
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<BoxSize> wielkos$¢ paczki (REQUIRED) 10 char
<PackValue> wartos¢ przesytki (w groszach) 6 char
<CashOnDelivery> paczka za pobraniem (true/false) boolean
<AmountCashOnDelivery> kwota pobrania (w groszach) 6 char
<Insurance> ubezpieczenie paczki (true/false) boolean
<EMail> adres email odbiorcy 60 char
<FirstName> imie odbiorcy 30 char
<LastName> nazwisko odbiorcy 30 char
<CompanyName> firma odbiorcy 70 char
<StreetName> ulica z adresu odbiorcy 30 char
<BuildingNumber> numer budynku z adresu odbiorcy | 10 char

numer mieszkania z adresu
<FlatNumber> odbiorcy 10 char
<City> miasto z adresu odbiorcy 30 char
<PostCode> kod pocztowy z adresu odbiorcy 6 char
<PhoneNumber> numer telefonu odbiorcy (REQUIRED) 9 char

<SenderEMail>

adres email nadawcy

(REQUIRED) 60 char

<SenderFirstName>

imie nadawcy

(REQUIRED) 30 char

<SenderLastName> nazwisko nadawcy (REQUIRED) 30 char
<SenderCompanyName> firma nadawcy 70 char
<SenderStreetName> ulica z adresu nadawcy (REQUIRED) 30 char

numer budynku z adresu

<SenderBuildingNumber> nadawcy (REQUIRED) 10 char

numer mieszkania z adresu
<SenderFlatNumber> nadawcy 10 char
<SenderCity> miasto z adresu nadawcy (REQUIRED) 30 char
<SenderPostCode> kod pocztowy z adresu nadawcy | (REQUIRED) 6 char
<SenderPhoneNumber> numer telefonu nadawcy (REQUIRED) 9 char
<SenderOrders> nr zamowienia nadawcy 30 char
<ReturnDestinationCode> kod POPeR do zwrotu 15 char
<ReturnEMail > adres email do zwrotu 60 char
<ReturnFirstName> imie osoby do zwrotu 30 char
<ReturnLastName> nazwisko osoby do zwrotu 30 char
<ReturnCompanyName> nazwa firm do zwrotu 70 char
<ReturnStreetName> ulica z adresu do zwrotu 30 char

numer budynku z adresu do
<ReturnBuildingNumber> zwrotu 10 char

numer mieszkania z adresu do
<ReturnFlatNumber> zwrotu 10 char
<ReturnCity> miasto z adresu do zwrotu 30 char
<ReturnPostCode> kod pocztowy z adresu do zwrotu | 6 char
<ReturnPhoneNumber> numer telefonu do zwrotu 9 char
<ReturnPack> paczka zwrotna (T -jesli zwrotna) 1 char

tytut przelewu dla paczki za
<TransferDescription> pobraniem 70 char

<PrintAdress>

wybdr adresu do wydruku przy
zwrocie (1- adres nadania, 2 -
adres zwrotu)

(REQUIRED) 1 char

<ReturnAvailable>

mozliwos¢ nadania paczki
zwrotnej (T -jesli tak)

1 char

<ReturnQuantity>

liczba paczek zwrotnych

1 char

<PrintType>

wybdr etykiety do wydruku (1-
petny adres, 2- adres
anonimowy)

(REQUIRED) 1 char

<AutoDestinationChange>

string
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TransferDescription nie moze zawieraé polskich znakdéw i specjalnych.
Pola <FirstName> i <LastName> sg obowigzkowe, chyba, ze podano wartos¢ w polu <CompanyName>.

Pola <SenderFirstName> i <SenderLastName> sg obowigzkowe, jesli nie podano wartos¢ w polu
<SenderCompanyName>.

Pole <ReturnDestinationCode> wypetniane jest tyko w przypadku: nadania w PSD i wyborze innego
PSD do zwrotu niz PSD w ktérym paczka zostanie nadana.

Przy wyborze punktu odbioru APM oraz PKN, pole <BoxSize> jest obowigzkowe i przyjmuje wartosci: S,
M lub L.

Przyktad z minimalng wymagana listg pol:
<PartnerlD>1234567890</Partner|D>
<PartnerKey>XAGWEGWw12</PartnerKey>
<DestinationCode>0130-6556-40-43</DestinationCode>
<FirstName>Jan</FirstName>
<LastName>Nowak</LastName>
<PhoneNumber>123456789</PhoneNumber>
<SenderEMail>test@tt.pl</SenderEMail>
<SenderCompanyName>Firma SA</SenderCompanyName>
<SenderStreetName>Prosta</SenderStreetName>
<SenderBuildingNumber>1234</SenderBuildingNumber>
<SenderCity>Warszawa</SenderCity>
<SenderPostCode>99-999</SenderPostCode>
<SenderPhoneNumber>123456789</SenderPhoneNumber>
<PrintAdress>1</PrintAdress>

<PrintType>1</PrintType>

3.9.2 Odpowiedz

PDF jest zwracany w Web.serwis jako output parametr.
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Zwracane wartosci:

<Err>

Numer btedu

<ErrDes>

Opis btedu

<PackCode_RUCH>

Numer EAN-13 przesytki

<DestinationCode>

Kod POPER (potwierdzenie lub zmiana)

<Destinationld>

Kod PSD

<PackPrice>

Cena przesytki (w groszach)

<PackPaid>

Optacenie przesytki true/false

<LabelData>

Etykieta PDF (Base 64)

Przyktad:

<Err>000</Err>

<ErrDes>saved</ErrDes>

<PackCode_RUCH>2900000000230</PackCode_RUCH>

<DestinationCode>0130-6556-40-43</DestinationCode>

<Destinationld>123680</Destinationld>

<PackPrice>745</PackPrice>

<PackPaid>false</PackPaid>

<LabelData>base64</LabelData>

3.10 GENERATENUMBERWAYBILLS

Metoda stuzy do pobrania puli numerdéw przesytek ORLEN Paczki.

Parametry wywotania:

3.10.1 Wywotanie

<PartneriD>

identyfikator Klienta nadany
przez RUCH

(REQUIRED) 10 char

<PartnerKey>

hasto Klienta nadane przez RUCH

(REQUIRED) 10 char

<NumberOfWaybills>

liczba listow do wygenerowania

(REQUIRED) 5 char

Przyktad:

<PartnerID>1234567890</PartnerID>

<PartnerKey>XAGWEGWw12</PartnerKey>

<NumberOfWaybills>2</NumberOfWaybills>
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3.10.2 Odpowiedz
Zwracane wartosci:

| <PackCode_RUCH> | Numer EAN-13 przesytki

Przyktad:
<PackCode_RUCH>2900000000230</PackCode_RUCH>

<PackCode_RUCH>2900000000231</PackCode_RUCH>

3.11 GENERATEPROTOCOL

Metoda stuzy do wygenerowania Protokotu (w formacie PDF) dla wskazanych nr paczek
zaawizowanych do RUCH. Dodatkowo metoda zwraca btedne paczki (wszystkie majgce inny status niz
zaawizowane) oraz poprawne paczki wraz numerem protokotu.

3.11.1 Wywotanie
Parametry wywotania:

identyfikator Klienta nadany
<PartnerlD> przez RUCH (REQUIRED) 10 char
<PartnerKey> hasto Klienta nadane przez RUCH | (REQUIRED) 10 char
<parcels> Numery EAN-13 przesytek (REQUIRED) List<bigint>

Przyktad z minimalng wymagana listg pol:
<PartnerID>1234567890</PartnerID>
<PartnerKey>XAGWEGWw12</PartnerKey>

<parcels>3400011680074, 3400011661721, 3400011680068</parcels>

3.11.2 Odpowiedz

Zwracane wartosci:

Parametr z Protokotem w formacie PDF: Out byte[] Label

<Err> Numer btedu gdy Err 210 — paczka o innym
statusie niz zaawizowana — nie zostanie dodana
do Protokotu

<ErrDes> Opis btedu
<ProtocolCode> numer protokotu (jesli err=0)
<PackCode RUCH> Numer EAN-13 przesytki
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<DATA_MOD>

Data modyfikacji statusu

<status>

Nr statusu

<status_opis>

Opis statusu

Przyktad:

0 OK 1000011680498 3400011680074 2015-07-15 08:12:25.040 200 W Transporcie od Nadawcy

210 NIE DODANE DO PROTOKOtU

NULL 3400011661721 2015-07-10 15:30:40.233 201 Anulowane awizo

210 NIE DODANE DO PROTOKOtU

NULL 3400011680068 2015-07-15 10:11:29.647 O

3.12 GENERATESHIPPINGCODE

Brak Paczki

Metoda stuzy do awizowania przesytki ORLEN Paczka WhiteLabel

Parametry wywotania:

3.121 Wywotanie

<PartneriD>

identyfikator Klienta nadany
przez RUCH

(REQUIRED) 10 char

<PartnerKey>

hasto Klienta nadane przez RUCH

(REQUIRED) 10 char

<PhoneNumber>

numer telefonu odbiorcy

(REQUIRED) 9 char

<DestinationCode>

kod POPeR

(REQUIRED) 15 char

<AlternativeDestinationCode> alternatywny kod POPeR 15 char

<BoxSize> wielkos$¢ paczki (REQUIRED) 10 char
<PackValue> wartosc¢ przesytki (w groszach) 6 char
<CashOnDelivery> paczka za pobraniem (true/false) boolean
<AmountCashOnDelivery> kwota pobrania (w groszach) 6 char

<Insurance> ubezpieczenie paczki (true/false) boolean
<EMail> adres email odbiorcy 60 char
<FirstName> imie odbiorcy 30 char
<LastName> nazwisko odbiorcy 30 char
<CompanyName> firma odbiorcy 70 char
<StreetName> ulica z adresu odbiorcy 30 char
<BuildingNumber> numer budynku z adresu odbiorcy | 10 char

numer mieszkania z adresu

<FlatNumber> odbiorcy 10 char

<City> miasto z adresu odbiorcy 30 char
<PostCode> kod pocztowy z adresu odbiorcy 6 char

<SenderEMail>

adres email nadawcy

(REQUIRED) 60 char

<SenderFirstName>

imie nadawcy

(REQUIRED) 30 char

<SenderLastName> nazwisko nadawcy (REQUIRED) 30 char
<SenderCompanyName> firma nadawcy 70 char
<SenderStreetName> ulica z adresu nadawcy (REQUIRED) 30 char

<SenderBuildingNumber>

numer budynku z adresu
nadawcy

(REQUIRED) 10 char

<SenderFlatNumber>

numer mieszkania z adresu
nadawcy

10 char
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<SenderCity>

miasto z adresu nadawcy

(REQUIRED) 30 char

<SenderPostCode> kod pocztowy z adresu nadawcy | (REQUIRED) 6 char
<SenderPhoneNumber> numer telefonu nadawcy (REQUIRED) 9 char
<SenderOrders> nr zamdwienia nadawcy 30 char
<ReturnDestinationCode> kod POPeR do zwrotu 15 char
<ReturnEMail > adres email do zwrotu 60 char
<ReturnFirstName> imie osoby do zwrotu 30 char
<ReturnLastName> nazwisko osoby do zwrotu 30 char
<ReturnCompanyName> nazwa firm do zwrotu 70 char
<ReturnStreetName> ulica z adresu do zwrotu 30 char

numer budynku z adresu do
<ReturnBuildingNumber> zwrotu 10 char

numer mieszkania z adresu do
<ReturnFlatNumber> zwrotu 10 char
<ReturnCity> miasto z adresu do zwrotu 30 char
<ReturnPostCode> kod pocztowy z adresu do zwrotu | 6 char
<ReturnPhoneNumber> numer telefonu do zwrotu 9 char
<ReturnPack> paczka zwrotna (T -jesli zwrotna) 1 char

tytut przelewu dla paczki za
<TransferDescription> pobraniem 70 char

<PrintAdress>

wybdr adresu do wydruku przy
zwrocie (1- adres nadania, 2 -
adres zwrotu)

(REQUIRED) 1 char

<ReturnAvailable>

mozliwos¢ nadania paczki
zwrotnej (T -jesli tak)

1 char

<ReturnQuantity>

liczba paczek zwrotnych

1 char

TransferDescription nie moze zawieraé polskich znakdéw i specjalnych.

Pola <FirstName> i <LastName> sg obowigzkowe, chyba, ze podano wartos$é¢ w polu <CompanyName>.

Pola <SenderFirstName> i <SenderLastName> sg obowigzkowe, jesli nie podano wartos¢ w polu

<SenderCompanyName>.

Pole <ReturnDestinationCode> wypetniane jest tyko w przypadku: nadania w PSD i wyborze innego
PSD do zwrotu niz PSD w ktérym paczka zostanie nadana.

Przy wyborze punktu odbioru APM oraz PKN, pole <BoxSize> jest obowigzkowe i przyjmuje wartosci: S,

M lub L.

Przyktad z minimalng wymagana listg pol:

<PartnerIlD>1234567890</PartnerID>

<PartnerKey>XAGWEGWw12</PartnerKey>

<DestinationCode>WS-101899-32-09</DestinationCode>

<FirstName>Jan</FirstName>

<LastName>Nowak</LastName>

<PhoneNumber>123456789</PhoneNumber>

<SenderEMail>test@tt.pl</SenderEMail>

<SenderCompanyName>Firma SA</SenderCompanyName>
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<SenderStreetName>Prosta</SenderStreetName>
<SenderBuildingNumber>1234</SenderBuildingNumber>
<SenderCity>Warszawa</SenderCity>
<SenderPostCode>99-999</SenderPostCode>
<SenderPhoneNumber>123456789</SenderPhoneNumber>

<PrintAdress>1</PrintAdress>

3.12.2 Odpowiedz

PDF jest zwracany w Web.serwis jako output parametr.

Zwracane wartosci:

<Err> Numer btedu

<ErrDes> Opis btedu

<ShippingCode> Kod nadania przesytki

<DestinationCode> Kod POPER (potwierdzenie lub zmiana)

<DestinationID> Kod PSD

<PackPrice> Cena przesytki (w groszach)

<PackPaid> Optacenie przesytki true/false
Przyktad:

<Err>000</Err>

<ErrDes>saved</ErrDes>
<ShippingCode>1234567</ShippingCode>
<DestinationCode>WS-101899-32-09</DestinationCode>
<Destinationld>101899</Destinationld>
<PackPrice>745</PackPrice>

<PackPaid>false</PackPaid>

3.13 GETGENERATEDPARCELS

Metoda stuzy do pobierania numerdw zaawizowanych paczek wraz z datg ich awizacji dla podanego
zakresu dat. W odpowiedzi zostang przekazane numery paczek nie starsze niz zaawizowane 30 dni
wczesniej.
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3.13.1 Wywotanie
Parametry wywotania:

identyfikator Klienta nadany
<PartneriD> przez RUCH (REQUIRED) 10 char
<PartnerKey> hasto Klienta nadane przez RUCH | (REQUIRED) 10 char
<dateFrom> data poczatkowa (YYYY-MM-DD) dateTime
<dateTo> data koricowa (YYYY-MM-DD) dateTime

Przyktad z minimalng wymagana lista pol:
<PartnerID>1234567890</Partner|D>
<PartnerKey>XAGWEGWw12</PartnerKey>
<dateFrom>2015-07-01</dateFrom>

<dateTo>2015-07-15</dateTo>

3.13.2 Odpowiedz

Zwracane wartosci:

<GetGeneratedParcels> - lista paczek (1 ... n)

<Err> Numer btedu
<ErrDes> Opis btedu
<PackCode_RUCH> Numery EAN-13 przesytek
<Data> Data zaawizowania przesyfki
Przyktad:
<Err>000</Err>

<ErrDes>saved</ErrDes>
<PackCode_RUCH>3400011619746</PackCode RUCH>

<Data>2015-07-01T00:13:33.757+02:00</Data>

3.14 GIVECURRENTPACK

Metoda stuzy do pobierania aktualnego numeru paczki w przypadku, gdy do paczki pierwotnej
zostata wygenerowana etykieta zwrotna.

3.141 Wywotanie
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Parametry wywotania:

| packCode | Numer EAN-13 przesytki

Przyktad z minimalng wymagana listg pol:
<packCode>3400011619746</packCode>

3.14.2 Odpowiedz

Zwracane wartosci:

<GiveCurrentPackResult>string</GiveCurrentPackResult>

| GiveCurrentPackResult Aktualny numer paczki

Przyktad:

<GiveCurrentPackResult>3400011619746</GiveCurrentPackResult>

3.15 GIVEMASTERPACK

Metoda stuzy do pobierania pierwotnego numeru paczki w przypadku, gdy otrzymaliSmy numer
paczki zwrotnej.

3.15.1 Wywotanie

Parametry wywotania:

| packCode | Numer EAN-13 przesytki |

Przyktad z minimalng wymagana listg pol:
<packCode>3400011619746</packCode>

3.15.2 Odpowiedz

Zwracane wartosci:

<GiveMasterPackResult>string</GiveMasterPackResult>

| GiveMasterPackResult numer paczki pierwotnej

Przyktad:

<GiveMasterPackResult>3400011619746</GiveMasterPackResult>
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3.16 GIVEMEALLPSDLOCATION

Lista wszystkich Kioskow w ramach ustugi ORLEN Paczka z rozszerzonym opisem lokalizacji.

Parametry wywotania:

3.16.1 Wywotanie

<PartneriD>

identyfikator Klienta nadany
przez RUCH

(REQUIRED) 10 char

<PartnerKey>

hasto Klienta nadane przez RUCH

(REQUIRED) 10 char

Przyktad z minimalng wymagana listg pol:

<PartnerlD>1234567890</Partner|D>
<PartnerKey>XAGWEGWw12</PartnerKey>

Zwracane wartosci:

3.16.1 Odpowiedz

<DestinationCode> Kod POPeR 15 char
Ulica na ktdrej miesci sie Punkt
<StreetName> Odbioru Paczek 30 char
Numer budynku gdzie miesci sie
<BuildingNumber> POP 5 char
<City> Miasto gdzie miesci sie POP 20 char
<District> Dzielnica gdzie miesci sie POP 20 char
<Latitude> Szerokos¢ geograficzna POP 10 char
<Longitude> Dtugos¢ geograficzna POP 10 char
<Province> Wojewddztwo 20 char

<CashOnDelivery>

Czy jest ustuga pobraniowa

(true/false) boolean

Informacja o godzinach otwarcia

<OpeningHours> POP 50 char
Opis lokalizacji Punktu Odbioru
<Location> Paczek 255 char
<PSD> Nr PSD 6 char
<Available> Czy POP jest dostepny T/N 1 char
Przyktad:

<DestinationCode>0130-3500-33-32</DestinationCode>
<StreetName>MARSZAtKOWSKA</StreetName>
<BuildingNumber>82</BuildingNumber>
<City>Warszawa</City>
<District>Srodmiescie</District>
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<Longitude>21.0137</Longitude>
<Latitude>52.2274</Latitude>
<Province>Mazowieckie</Province>
<CashOnDelivery>false</CashOnDelivery>
<OpeningHours>Pn-Pt:06:00-19:00, S0:06:00-15:00, Nd: nieczynne</OpeningHours>

<Location>Kiosk z okienkiem, zlokalizowany na rogu ul. Wspdlnej i Marszatkowskiej, na odcinku miedzy

ul. Wspdlng a ul. Nowogrodzka. </Location>
<PSD>951632</PSD>
<Available>T</Available>
<PointType>PSD</PointType>

3.17 GIVEMEALLLOCATIONWITHALLDATA

Metoda zwraca rozszerzone dane dla wszystkich punktéw dostepnych w ustudze ORLEN Paczka.

3.171 Wywotanie

Parametry wywotania:

BRAK

Zwracane wartosci:

3.17.2 Odpowiedz

punktu dla dostaw kurierskich

<DestinationCode> | kod POPer 15 char
<StreetName> ulica z adresu odbiorcy 30 char
<City> miasto z adresu odbiorcy 20 char
<District> dzielnica 20 char
<Longitude> dtugosé geograficzna 10 char
<Latitude> szerokos$¢ geograficzna 10 char
<Province> wojewoddztwo 20 char
<CashOnDelivery> | czy jest dostepna ustuga pobraniowa w punkcie odbioru (true/false) boolean
<OpeningHours> | godziny otwarcia punktu odbioru 50 char
<Location> opis lokalizacji punktu odbioru 255 char
<PSD> unikatowy 6-cyfrowy numer ID punktu odbioru 6 char
<Available> czy punkt jest dostepny w ustudze ORLEN Paczka (T/N) 1 char
<Obszar> obszar punktu odbioru 20 char
<Mikrorejon> mikrorejon punktu odbioru 20 char
<Skrotnrpok> skrét numeru ID punktu odbioru 20 char
<Sortownia> sortownia, do ktérej przypisany jest punkt odbioru 20 char
<Presort> 20 char
<Cras> parametr na potrzeby kurierskie, dot. czasu dostepnosci 50 char

Przyktadowa odpowiedz:

<?xml version="1.0" encoding="utf-8"?>

<soap:Envelope xmlIns:soap="http://schemas.xmlsoap.org/soap/envelope/" xmlins:xsi="http://www.w3.0rg/20

01/XMLSchema-instance" xmlIns:xsd="http://www.w3.0rg/2001/XMLSchema">

<soap:Body>
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<GiveMeAllLocationWithAllIDataResponse xmlns="https://91.242.220.103/WebServicePwR">
<GiveMeAllLocationWithAllDataResult>
<xs:schema id="NewDataSet" xmlns=

xmlns:xs="http://www.w3.0rg/2001/XMLSchema" xmlIns:msd
ata="urn:schemas-microsoft-com:xml-msdata">
<xs:element name="NewDataSet" msdata:IsDataSet="true" msdata:UseCurrentLocale="true">
<xs:complexType>
<xs:choice minOccurs="0" maxOccurs="unbounded">
<xs:element name="LocationWithAllData">
<xs:complexType>
<xs:sequence>
<xs:element name="DestinationCode" type="xs:string" minOccurs="0" />
<xs:element name="StreetName" type="xs:string" minOccurs="0" />
<xs:element name="BuildingNumber" type="xs:string" minOccurs="0" />
<xs:element name="City" type="xs:string" minOccurs="0" />
<xs:element name="District" type="xs:string" minOccurs="0" />
<xs:element name="Longitude" type="xs:string" minOccurs="0" />
<xs:element name="Latitude" type="xs:string" minOccurs="0" />
<xs:element name="Province" type="xs:string" minOccurs="0" />
<xs:element name="CashOnDelivery" type="xs:boolean" minOccurs="0" />
<xs:element name="0peningHours" type="xs:string" minOccurs="0" />
<xs:element name="Location" type="xs:string" minOccurs="0" />
<xs:element name="PSD" type="xs:string" minOccurs="0" />
<xs:element name="Available" type="xs:string" minOccurs="0" />
<xs:element name="0Obszar" type="xs:string" minOccurs="0" />
<xs:element name="Mikrorejon" type="xs:string" minOccurs="0" />
<xs:element name="Skrotnrpok" type="xs:string" minOccurs="0" />
<xs:element name="Sortownia" type="xs:string" minOccurs="0" />
<xs:element name="Presort" type="xs:string" minOccurs="0" />
<xs:element name="Czas" type="xs:string" minOccurs="0" />
<xs:element name="PointType" type="xs:string" minOccurs="0" />
<xs:element name="NearestPoints" msdata:DataType="System.Collections.Generic.Lis
t'1[[Pwr.Common.Models.NearestPoint, Pwr.Common.Models, Version=1.0.0.0, Culture=neutral, PublicKeyTok
en=null]], mscorlib, Version=4.0.0.0, Culture=neutral, PublickeyToken=b77a5c561934e089" type="xs:anyType"
minOccurs="0" />
</xs:sequence>
</xs:complexType>
</xs:element>
</xs:choice>
</xs:complexType>
</xs:element>
</xs:schema>
<diffgr:diffgram xmins:msdata="urn:schemas-microsoft-com:xml-msdata" xmlIns:diffgr="urn:schemas-
microsoft-com:xml-diffgram-v1">
<NewDataSet xmlns="">
<LocationWithAllData diffgr:id="LocationWithAllDatal" msdata:rowOrder="0">
<DestinationCode>WS-100001-27-26</DestinationCode>
<StreetName>ANNOPOL 17 TEST</StreetName>
<City>Warszawa</City>
<District>Warszawa</District>
<Longitude>21.013830</Longitude>
<Latitude>52.311519</Latitude>

43 API_ORLENPaczka_v_1_23_003



<Province>Mazowieckie</Province>
<CashOnDelivery>true</CashOnDelivery>
<OpeningHours>Pn-Pt:00:00-24:00, S0:00:00-24:00, Nd:00:00-24:00</OpeningHours>
<Location>Punkt testowy</Location>
<PSD>100001</PSD>
<Available>T</Available>
<Obszar>MIN</Obszar>
<Mikrorejon>WSK6</Mikrorejon>
<Skrotnrpok>K6-55</Skrotnrpok>
<Sortownia />
<Czas>XX</Czas>
<PointType>PSD</PointType>
<NearestPoints>
<NearestPoint>
<Name>Warszawa Chodecka 13 </Name>
<Distance>2179</Distance>
</NearestPoint>
<NearestPoint>
<Name>Warszawa Chodecka 13 </Name>
<Distance>2179</Distance>
</NearestPoint>
<NearestPoint>
<Name>Warszawa Chodecka 13 </Name>
<Distance>2179</Distance>
</NearestPoint>
</NearestPoints>
</LocationWithAllData>

3.18 GIVEMEALLAPMLOCATION

Lista Automatycznych Maszyn Paczkowych APM oraz Punktéw PKN w ramach ustugi ORLEN Paczka z

rozszerzonym opisem lokalizacji.

3.18.1 Wywotanie

Parametry wywotania:

<PartneriD>

identyfikator Klienta nadany
przez RUCH

(REQUIRED) 10 char

<PartnerKey>

hasto Klienta nadane przez RUCH

(REQUIRED) 10 char

Zwracane wartosci:

3.18.1 Odpowiedz

<DestinationCode> | Kod POPeR 15 char
<StreetName> Ulica na ktérej miesci sie Punkt Odbioru Paczek 30 char
<City> Miasto gdzie miesci sie POP 20 char
<District> Dzielnica gdzie miesci sie POP 20 char
<Zipcode> Kod pocztowy POP 6 char
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<Longitude>

Dtugos¢ geograficzna POP

10 char

<Latitude>

Szerokos¢ geograficzna POP

10 char

<Province>

Wojewddztwo

20 char

<CashOnDelivery>

Czy jest ustuga pobraniowa

(true/false) boolean

<OpeningHours>

Informacja o godzinach otwarcia POP

50 char

<Location> Opis lokalizacji Punktu Odbioru Paczek 255 char
<PSD> Nr PSD 6 char
<Available> Czy POP jest dostepny T/N 1 char
<PointType> Rodzaj Punktu/Automatu (automat - APM, stacja Orlen — PKN) 3 char

Przyktad:

<AllApmLocation diffgr:id="AllApmLocation3" msdata:rowOrder="2">
<DestinationCode>LB-524373-20-13</DestinationCode>
<StreetName>LUBARTOWSKA 12</StreetName>
<City>Kamionka</City>

<District>Kamionka</District>

<Zipcode>21-132</Zipcode>

<Longitude>22.4643</Longitude>

<Latitude>51.4695</Latitude>

<Province>Lubelskie</Province>
<CashOnDelivery>false</CashOnDelivery>
<OpeningHours>Pn-Pt:08:00-17:00, S0:08:00-15:00, Nd: nieczynne</OpeningHours>
<Location>APM </Location>
<PSD>524373</PSD>
<Available>T</Available>
</AllApmLocation>

3.19 GIVEMEALLRUCHLOCATION

Lista Punktéw/Kioskéw Wtasnych i Punktéw/Kioskdw Partnerskich oraz Automatycznych Maszyn
Paczkowych APM i Punktéw PKN w ramach ustugi ORLEN Paczka z rozszerzonym opisem lokalizacji.

3.19.1 Wywotanie

Parametry wywotania:

<PartneriD>

identyfikator Klienta nadany
przez RUCH

(REQUIRED) 10 char

<PartnerKey>

hasto Klienta nadane przez RUCH

(REQUIRED) 10 char

Zwracane wartosci:
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<DestinationCode> Kod POPeR 15 char
Ulica na ktérej miesci sie Punkt
<StreetName> Odbioru Paczek 30 char
Numer budynku gdzie miesci sie
<BuildingNumber> POP 5 char
<City> Miasto gdzie miesci sie POP 20 char
<District> Dzielnica gdzie miesci sie POP 20 char
<Latitude> Szerokos¢ geograficzna POP 10 char
<Longitude> Dtugos¢ geograficzna POP 10 char
<Province> Wojewoddztwo 20 char

<CashOnDelivery>

Czy jest ustuga pobraniowa

(true/false) boolean

Informacja o godzinach otwarcia

<OpeningHours> POP 50 char
Opis lokalizacji Punktu Odbioru
<Location> Paczek 255 char
<PSD> Nr PSD 6 char
<Available> Czy POP jest dostepny T/N 1 char
Rodzaj Punktu/Kiosku (wtasny -
PSD, partnerski — PSP, PPP, PSF,
PPK, automat - APM, stacja Orlen
<PointType> — PKN) 3 char

Przyktad:

< DestinationCode>BD-105239-46-43</DestinationCode>

<StreetName>POZNANSKA 5<
<City>Inowroctaw</City>

/StreetName>

<District>Inowroctaw</District>
<Longitude>18.2615</Longitude>
<Latitude>52.7936</Latitude>
<Province>Kujawsko-Pomorskie</Province>
<CashOnDelivery>true</CashOnDelivery>
<OpeningHours>Pn-Pt:06:00-18:00, S0:07:00-14:00, Nd: nieczynne</OpeningHours>
<Location>Kiosk z okienkiem, znajdujacy sie przy ulicy Poznanskiej 5, usytuowany w ciggu
matych punktéw ustugowych: sklep miesny, biuro podrézy, postdj takséwek.</Location>

<PSD>105239</PSD>
<Available>T</Available>
<PointType>PSD</PointType>

3.20 GIVEMEALLRUCHZIPCcODE

Lista Punktéw/Kioskéw Wtasnych i Punktéw/Kioskow Partnerskich w ramach ustugi ORLEN Paczka z
rozszerzonym opisem lokalizacji i informacja o kodzie pocztowym.

3.20.1 Wywotanie

Parametry wywotania:

identyfikator Klienta nadany
<PartneriD> przez RUCH (REQUIRED) 10 char
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<PartnerKey>

hasto Klienta nadane przez RUCH | (REQUIRED) 10 char

Zwracane wartosci:

3.20.2 Odpowiedz

<DestinationCode> Kod POPeR 15 char
Ulica na ktorej miesci sie Punkt
<StreetName> Odbioru Paczek 30 char
Numer budynku, gdzie miesci sie
<BuildingNumber> POP 5 char
<City> Miasto, gdzie miesci sie POP 20 char
<District> Dzielnica, gdzie miesci sie POP 5 char
<Latitude> Szerokos¢ geograficzna POP 10 char
<Longitude> Dtugos¢ geograficzna POP 10 char
<Province> Wojewddztwo 20 char
<CashOnDelivery> Czy ustuga pobraniowa Boolean
Informacja o godzinach otwarcia
<OpeningHours> POP 50 char
Opis lokalizacji Punktu Odbioru
<Location> Paczek 255 char
<PSD> Nr PSD 6 char
<Available> Czy POP jest dostepny T/N 1 char
<Zipcode> Kod pocztowy POP 6 char
Przyktad:

< DestinationCode>BD-105239-46-43</DestinationCode>
<StreetName>POZNANSKA 5</StreetName>

<City>Inowroctaw</City>

<District>Inowroctaw</District>
<Longitude>18.2615</Longitude>
<Latitude>52.7936</Latitude>
<Province>Kujawsko-Pomorskie</Province>

<CashOnDelivery>true</CashOnDelivery>
<OpeningHours>Pn-Pt:06:00-18:00, S0:07:00-14:00, Nd: nieczynne</OpeningHours>
<Location>Kiosk z okienkiem, znajdujacy sie przy ulicy Poznanskiej 5, usytuowany w ciggu matych

punktow ustugowych: sklep miesny, biuro podrézy, postéj takséwek.</Location>

<PSD>105239</PSD>
<Available>T</Available>

<PointType>PSD</PointType>

<Zipcode>12-345</ Zipcode >
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3.21 GIVEMEALLRUCHWITHFILLED

Lista Punktéw/Kioskdw Wtasnych i Punktéw/Kioskdw Partnerskich oraz Automatycznych Maszyn
Paczkowych APM i Punktéw PKN w ramach ustugi ORLEN Paczka z rozszerzonym opisem lokalizacji
oraz uwzglednieniem parametru przepetnienia. W przypadku przepetnionego punktu, zwracane jest
do 5 punktéw alternatywnych znajdujgcych sie w obrebie 1,5 km od przepetnionego punktu.

Parametry wywotania:

3.21.1 Wywotanie

<PartneriD>

identyfikator Klienta nadany
przez RUCH

(REQUIRED)10 char

<PartnerKey>

hasto Klienta nadane przez RUCH

(REQUIRED)10 char

Przyktad z minimalng wymagana listg pol:

<PartnerID>1234567890</PartnerID>

<PartnerKey>XAGWEGWw12</PartnerKey>

Zwracane wartosci:

3.21.2 Odpowiedz

<Err> Numer btedu

<ErrDes> Opis btedu

<Data> Lista punktéw w ramach Ustugi ORLEN Paczka
Data struktura

<PointPwR> | Dane punktu w ramach ustugi ORLEN Paczka

PointPwR struktura

<DestinationCode> Kod POPeR 15 char
Ulica na ktorej miesci sie Punkt

<StreetName> Odbioru Paczek 30 char
Numer budynku gdzie miesci sie

<BuilingNumber> POP 5 char

<City> Miasto gdzie miesci sie¢ POP 20 char

<District> Dzielnica gdzie miesci sie POP 20 char

<Latitude> Szerokosc¢ geograficzna POP 10 char

<Longitude> Dtugos¢ geograficzna POP 10 char

<Province> Wojewddztwo 20 char
Czy jest ustuga pobraniowa

<CashOnDelivery> true/false boolean
Informacja o godzinach otwarcia

<OpeningHours> POP 50 char
Opis lokalizacji Punktu Odbioru

<Location> Paczek 255 char

<PSD> Nr PSD 6 char
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Rodzaj Punktu/Kiosku (wtasny - PSD,
partnerski — PSP, PPP, PSF, PPK,

<PointType> automat - APM, stacja Orlen — PKN) | 3 char
Stan przepetnienia punktu
<Filled> true/false boolean
Lista zawierajgca do 5
sugerowanych punktéw
alternatywnych (dostepna w
<Suggestions xsi:nil="true" /> przypadku przepetnienia) (1...5)
<Available> Czy POP jest dostepny T/N 1 char
<ZipCode> Kod pocztowy POP 6 char

Suggestions struktura

<PointPwRSuggestion>

Dane sugerowanego punktu alternatywnego w
ramach ustugi ORLEN Paczka

PointPwRSuggestion struktura

<DestinationCode> Kod POPeR 15 char
<PSD> Nr PSD 6 char
Odlegtos¢ od przepetnionego
<Distance> punktu wyrazona w km 6 char
Przyktad:

<Err>0</Err>

<ErrDes>0OK</ErrDes>

<Data>

<PointPwR>

<DestinationCode>BD-106088-31-40</DestinationCode>
<StreetName>POWSTANCOW WIELKOPOLSKICH 53</StreetName>

<City>Bydgoszcz</City>

<District>Bydgoszcz</District>
<Latitude>53.1303</Latitude>
<Longitude>18.0389</Longitude>
<Province>Kujawsko-Pomorskie</Province>
<CashOnDelivery>true</CashOnDelivery>
<OpeningHours>Pn-Pt:06:00-18:00, S0:07:00-14:00, Nd: nieczynne</OpeningHours>
<Location>Kiosk z wejsciem, znajdujacy sie na ul. Powstancéw Wielkopolskich, przy skrzyzowaniu

ulic Powstancéw Wielkopolskich z Wyszyriskiego. Obok znajduje sie kwiaciarnia.</Location>

<PSD>106088</PSD>

<PointType>PSD</PointType>

<Filled>true</Filled>

<Suggestions>

<PointPwRSuggestion>

<DestinationCode>BD-185280-31-26</DestinationCode>

<PSD>185280</PSD>

<Distance>0.4815</Distance>

</PointPwRSuggestion>
<PointPwRSuggestion>
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<DestinationCode>BD-268086-31-01</DestinationCode>
<PSD>268086</PSD>
<Distance>0.5564</Distance>

</PointPwRSuggestion>

<PointPwRSuggestion>
<DestinationCode>BD-785576-31-21</DestinationCode>
<PSD>785576</PSD>
<Distance>0.6301</Distance>

</PointPwRSuggestion>

<PointPwRSuggestion>
<DestinationCode>BD-857086-31-41</DestinationCode>
<PSD>857086</PSD>
<Distance>0.7714</Distance>

</PointPwRSuggestion>

<PointPwRSuggestion>
<DestinationCode>BD-640946-31-30</DestinationCode>
<PSD>640946</PSD>
<Distance>1.0583</Distance>

</PointPwRSuggestion>

</Suggestions>

<Available>true</Available>
<ZipCode>03-236</ZipCode>
</PointPwR>
<PointPwR>

</PointPwR>

</Data>

3.22 GIVEMEALLRUCHWITHFILLEDDA

Lista Punktéw/Kioskéw Wtasnych i Punktéw/Kioskdw Partnerskich oraz Automatycznych Maszyn

Paczkowych APM i Punktéw PKN spetniajgcych zatozenia dostawy w terminie D+1 w ramach ustugi
ORLEN Paczka z rozszerzonym opisem lokalizacji oraz uwzglednieniem parametru przepetnienia. W
przypadku przepetnionego punktu, zwracane jest do 5 punktéw alternatywnych znajdujgcych sie w
obrebie 1,5 km od przepetnionego punktu.

3.221 Wywotanie

Parametry wywotania:

<PartneriD>

identyfikator Klienta nadany
przez RUCH

(REQUIRED)10 char

<PartnerKey>

hasto Klienta nadane przez RUCH

(REQUIRED)10 char

Przyktad z minimalng wymagana listg pol:

<PartnerlD>1234567890</Partner|D>

50

API_ORLENPaczka_v_1_23_003




<PartnerKey>XAGWEGWw12</PartnerKey>

Zwracane wartosci:

3.22.2 Odpowiedz

<Err> Numer btedu

<ErrDes> Opis btedu

<Data> Lista punktéw w ramach Ustugi ORLEN Paczka
Data struktura

<PointPwR> Dane punktu w ramach ustugi ORLEN Paczka

PointPwR struktura

<DestinationCode> Kod POPeR 15 char
Ulica na ktorej miesci sie Punkt
<StreetName> Odbioru Paczek 30 char
Numer budynku gdzie miesci sie
<BuilingNumber> POP 5 char
<City> Miasto gdzie miesci sie POP 20 char
<District> Dzielnica gdzie miesci sie POP 20 char
<Latitude> Szeroko$¢ geograficzna POP 10 char
<Longitude> Dtugos¢ geograficzna POP 10 char
<Province> Wojewoddztwo 20 char
Czy jest ustuga pobraniowa
<CashOnDelivery> true/false boolean
Informacja o godzinach otwarcia
<OpeningHours> POP 50 char
Opis lokalizacji Punktu Odbioru
<Location> Paczek 255 char
<PSD> Nr PSD 6 char
Rodzaj Punktu/Kiosku (wtasny - PSD,
partnerski — PSP, PPP, PSF, PPK,
<PointType> automat - APM, stacja Orlen — PKN) | 3 char
Stan przepetnienia punktu
<Filled> true/false boolean
Lista zawierajaca do 5
sugerowanych punktow
alternatywnych (dostepna w
<Suggestions xsi:nil="true" /> przypadku przepetnienia) (1...5)
<Available> Czy POP jest dostepny T/N 1 char
<ZipCode> Kod pocztowy POP 6 char

Suggestions struktura

<PointPwRSuggestion>

Dane sugerowanego punktu alternatywnego w
ramach ustugi ORLEN Paczka

PointPwRSuggestion struktura

<DestinationCode> Kod POPeR 15 char

<PSD> Nr PSD 6 char
Odlegtos¢ od przepetnionego

<Distance> punktu wyrazona w km 6 char
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Przyktad:

<Err>0</Err>
<ErrDes>0OK</ErrDes>
<Data>
<PointPwR>
<DestinationCode>BD-106088-31-40</DestinationCode>
<StreetName>POWSTANCOW WIELKOPOLSKICH 53</StreetName>
<City>Bydgoszcz</City>
<District>Bydgoszcz</District>
<latitude>53.1303</Latitude>
<Longitude>18.0389</Longitude>
<Province>Kujawsko-Pomorskie</Province>
<CashOnDelivery>true</CashOnDelivery>
<OpeningHours>Pn-Pt:06:00-18:00, S0:07:00-14:00, Nd: nieczynne</OpeningHours>
<Location>Kiosk z wejsciem, znajdujacy sie na ul. Powstancéw Wielkopolskich, przy skrzyzowaniu
ulic Powstancéw Wielkopolskich z Wyszyriskiego. Obok znajduje sie kwiaciarnia.</Location>
<PSD>106088</PSD>
<PointType>PSD</PointType>
<Filled>true</Filled>
<Suggestions>
<PointPwRSuggestion>
<DestinationCode>BD-185280-31-26</DestinationCode>
<PSD>185280</PSD>
<Distance>0.4815</Distance>
</PointPwRSuggestion>
<PointPwRSuggestion>
<DestinationCode>BD-268086-31-01</DestinationCode>
<PSD>268086</PSD>
<Distance>0.5564</Distance>
</PointPwRSuggestion>
<PointPwRSuggestion>
<DestinationCode>BD-785576-31-21</DestinationCode>
<PSD>785576</PSD>
<Distance>0.6301</Distance>
</PointPwRSuggestion>
<PointPwRSuggestion>
<DestinationCode>BD-857086-31-41</DestinationCode>
<PSD>857086</PSD>
<Distance>0.7714</Distance>
</PointPwRSuggestion>
<PointPwRSuggestion>
<DestinationCode>BD-640946-31-30</DestinationCode>
<PSD>640946</PSD>
<Distance>1.0583</Distance>
</PointPwRSuggestion>
</Suggestions>
<Available>true</Available>
<ZipCode>03-236</ZipCode>
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</PointPwR>
<PointPwR>

</PointPwR>

</Data>

3.23 GIVEMEPSDZipcopE

Lista Kioskow w ramach ORLEN Paczka z podanego wojewddztwa z rozszerzonym opisem lokalizacji.

Parametr wywotania:

3.23.1 Wywotanie

BRAK

Zwracane wartosci:

3.23.1 Odpowiedz

<DestinationCode> Kod POPeR 15 char
Ulica na ktdrej miesci sie Punkt
<StreetName> Odbioru Paczek 30 char
Numer budynku gdzie miesci sie
<BuildingNumber> POP 5 char
<City> Miasto gdzie miesci sie POP 20 char
<District> Dzielnica gdzie miesci sie POP 20 char
<Latitude> Szerokos¢ geograficzna POP 10 char
<Longitude> Dtugos¢ geograficzna POP 10 char
<Province> Wojewddztwo 20 char

<CashOnDelivery>

Czy jest ustuga pobraniowa

(true/false) boolean

Informacja o godzinach otwarcia

<OpeningHours> POP 50 char
Opis lokalizacji Punktu Odbioru
<Location> Paczek 255 char
<PSD> Nr PSD 6 char
<Available> Dostepnos¢ punktu 1 char
Przyktad:

<DestinationCode>0130-3500-33-32</DestinationCode>
<StreetName>MARSZAtKOWSKA</StreetName>
<BuildingNumber>82</BuildingNumber>

<City>Warszawa</City>

<District>Srédmiescie</District>
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<Longitude>21.0137</Longitude>
<Latitude>52.2274</Latitude>
<Province>Mazowieckie</Province>
<CashOnDelivery>false</CashOnDelivery>
<OpeningHours>Pn-Pt:06:00-19:00, S0:06:00-15:00, Nd: nieczynne</OpeningHours>

<Location>Kiosk z okienkiem, zlokalizowany na rogu ul. Wspdlnej i Marszatkowskiej, na odcinku miedzy

ul. Wspdlng a ul. Nowogrodzka. </Location>

<PSD>951632</PSD>
<Available>T</Available>

3.24 GIVEMEPACKSTATUS

Metoda zwracajaca aktualny status paczki w ramach ustugi ORLEN Paczka.

Parametry wywotania:

3.241 Wywotanie

<PartneriD>

identyfikator Klienta nadany
przez RUCH

(REQUIRED)10 char

<PartnerKey> hasto Klienta nadane przez RUCH | (REQUIRED)10 char
<PackCode> numer kodu paczki zaawizowanej | 13 char
<PhoneNumber> numer telefonu odbiorcy 9 char
3.24.2 Odpowiedz
Zwracane wartosci:

<PackCode> numer kodu paczki zaawizowanej | 13 char

<Trans> status paczki 4 char
<Trans_Des> opis statusu 40 char

<Data>

data od kiedy paczka jest w
statusie

YYYY-MM-DDThh:mm:ssTZD

<Destination>

Kod POPeR

15 char

Przyktad:

<PackCode>2900000000230</PackCode>

<Trans>680</Trans>

<Trans_Des>W Transporcie do Kiosku</Trans_Des>

<Data>2013-12-14T04:35:10+01:00</Data>

<Destination>0130-6556-40-43</Destination>
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3.25 GIVEMEPACKSTATUSLIST

Metoda zwracajaca aktualng liste statuséw paczek w ramach ustugi ORLEN Paczka.

Parametry wywotania:

3.251 Wywotanie

<PackCodes>

Lista numeréw paczek

(REQUIRED) (iloéé 1 ... n)

<PartneriD>

identyfikator Klienta nadany
przez RUCH

(REQUIRED)10 char

<PartnerKey> hasto Klienta nadane przez RUCH | (REQUIRED)10 char
<PackCodes> struktura
<PackCode> | numer kodu paczki | (REQUIRED)13 char

Przyktad z minimalng wymagana listg pol:

<PackCodelist>

<string>3400016492733</string>

</PackCodelList>

<PartnerID>1234567890</PartnerID>
<PartnerKey>XAGWEGWw12</PartnerKey>

Zwracane wartosci:

3.25.2 Odpowiedz

<PackCode> numer kodu paczki zaawizowanej | 13 char
<Trans> status paczki 4 char
<Trans_Des> opis statusu 40 char

<Data>

data od kiedy paczka jest w
statusie

YYYY-MM-DDThh:mm:ssTZD

<Destination>

Kod POPeR

15 char

Przyktad:

</xs:schema>

<diffgr:diffgram xmiIns:msdata="urn:schemas-microsoft-com:xml-msdata" xmins:diffgr="urn:schemas-

microsoft-com:xml-diffgram-v1">

<NewDataSet xmlns="">

<PackStatus diffgr:id="PackStatus1" msdata:rowOrder="0">
<PackCode>3400016492733</PackCode>

<Trans>200</Trans>

<Trans_Des>W Transporcie od Nadawcy</Trans_Des>

<Data>2017-11-13T15:33:02
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<Destination>GD-432138-53-55</Destination>

</PackStatus>

3.26 GIVEMEPACKSTATUSFULLHISTORY

Metoda pozwalajgca pobrac petng historie paczki, jesli status paczki zmienit sie w ostatnich 10

dniach.

Parametry wywotania:

3.26.1 Wywotanie

<PackCode>

numer kodu paczki

(REQUIRED)13 char

<PartneriD>

identyfikator Klienta nadany
przez RUCH

(REQUIRED)10 char

<PartnerKey>

hasto Klienta nadane przez RUCH

(REQUIRED)10 char

Przyktad z minimalng wymagana lista pol:

<PackCode>3400017462421</PackCode>

<PartnerID>TEST000601</PartneriD>

<PartnerKey>B87FDC41E2</PartnerKey>

3.26.2 Odpowiedz

Zwracane wartosci:<PackCode> | numer kodu paczki zaawizowanej 13 char
<Trans> status paczki 4 char
Trans_Des> opis statusu 40 char
data od kiedy paczka jest w
<Data> statusie YYYY-MM-DDThh:mm:ssTZD
<Destination> kod POPeR 15 char

<Cl_From>

nr Centrum Logistycznego, na
obszarze ktérego przesytka zostata
nadana

4 char

<Cl_From_Des>

CL, na obszarze ktérego przesytka
zostata nadana

9 char

<Cl>

CL, na obszar ktérego przesytka
zostata zaawizowana

9 char

<Cl_Des>

Nr CL, na obszar ktérego przesytka
zostata zaawizowana

4 char

<Attribute>

atrybut przesytki (MOBILNY —
punkt mobilny, ALTERNATYWNY —
punkt alternatywny, ZMIENIONY —
punkt zmieniony, POWROT —
powrot przesytki do kiosku

12 char
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nadania, 2_POWROT — powrot
przesytki do magazynu nadania,
ZWROT - paczka zwrotna do
magazynu nadawcy)

ulica na ktdrej miesci sie Punkt

<StreetName> Odbioru Paczek 30 char

<City> miasto gdzie miesci sie POP 20 char
informacja o godzinach otwarcia

<OpeningHours> POP 50 char
Opis lokalizacji Punktu Odbioru

<Location> Paczek 255 char

</xs:schema>

<diffgr:diffgram xmIns:msdata="urn:schemas-microsoft-com:xml-msdata" xmlns:diffgr="urn:schemas-

microsoft-com:xml-diffgram-v1">
<NewDataSet xmlns="">

<PackStatus diffgr:id="PackStatus1" msdata:rowOrder="0">
<PackCode>400017462421</PackCode>

<Trans>200</Trans>

<Trans_Des>W Transporcie od Nadawcy</Trans_Des>
<Data>2021-01-08T09:03:00Z</Data>
<Destination>WR-561043-11-11</Destination>
<Cl_From>0000</Cl_From>

<Cl_From_Des />
<CI>9305</Cl>
<Cl_Des />
<Attribute />

<StreetName>KOLBERGA 1</StreetName>

<City>Jelenia Goéra</City>

<OpeningHours>Pn-Pt:07:00-17:00, S0:08:00-14:00, Nd: nieczynne</OpeningHours>
<Location>Kiosk z wejsciem, znajdujacy sie okoto 50 metréw od sklepu Jubilat. W poblizu skrzyzowanie z ulica

Kartowicza prowadzacej do ul. Ogiriskiego.</Location>

</PackStatus>

3.27 GIVEMEPACKSTATUSFULLHISTORYLIST

Metoda zwracajaca historie statuséw paczki w ramach listy paczek.

Parametry wywotania:

3.271 Wywotanie

<PackCodes>

Lista numerdow paczek (EAN 13)

(REQUIRED) (ilo$¢ 1...n)

<PartneriD>

identyfikator Klienta nadany
przez RUCH

(REQUIRED) 10 char

<PartnerKey>

hasto Klienta nadane przez RUCH

(REQUIRED) 10 char

Przyktad z minimalng wymagana listg pol:
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<PackCodes>
<PackCode>3400012345678</PackCode>
</PackCodes>
<PartnerlD>1234567890</Partner|D>
<PartnerKey>XAGWEGWw12</PartnerKey>

3.27.2 Odpowiedz

<PackCode> numer kodu paczki zaawizowanej | 13 char
<Trans> status paczki 4 char
<Trans_Des> opis statusu 40 char

data od kiedy paczka jest w
<Data> statusie

YYYY-MM-DDThh:mm:ssTZD

<Destination> kod POPeR

15 char

nr Centrum Logistycznego, na
obszarze ktérego przesytka

<Cl_From> zostata nadana 4 char
CL, na obszarze ktérego przesytka
<Cl_From_Des> zostata nadana 9 char
CL, na obszar ktérego przesytka
<Cl> zostata zaawizowana 9 char
Nr CL, na obszar ktérego przesytka
<Cl_Des> zostata zaawizowana 4 char
atrybut przesytki (MOBILNY —
punkt mobilny, ALTERNATYWNY —
punkt alternatywny, ZMIENIONY —
punkt zmieniony, POWROT —
powrét przesytki do kiosku
nadania, 2_POWROT — powrot
przesytki do magazynu nadania,
ZWROT - paczka zwrotna do
<Attribute> magazynu nadawcy) 12 char
ulica na ktdrej miesci sie Punkt
<StreetName> Odbioru Paczek 30 char
<City> miasto gdzie miesci sie POP 20 char
informacja o godzinach otwarcia
<OpeningHours> POP 50 char
Opis lokalizacji Punktu Odbioru
<Location> Paczek 255 char
Przyktad:

<PackCode>3400012345678</PackCode>
<Trans>200</Trans>

<Trans_Des>W Transporcie od Nadawcy</Trans_Des>
<Data>2018-01-15T12:00:00+01:00</Data>
<Destination>PZ-730614-04-38</Destination>
<Cl_From>0000</Cl_From>
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<Cl_From_Des>SC</Cl_From_Des>

<CI>6306</Cl>

<Cl_Des>POZNAN</Cl_Des>

<Attribute />

<StreetName>Jasielska 11</StreetName>

<City>Poznan</City>

<OpeningHours>Pn-Pt:06:00-16:00, So: nieczynne, Nd: nieczynne</OpeningHours>

<Location>Kiosk z okienkiem, usytuowany na ul. Jasielskiej, przy magazynach, naprzeciwko

Aviva.</Location>

3.28 GIVEPARTNERSTATUS

Metoda stuzy do pobrania informacji o kliencie ORLEN Paczki.

Parametry wywotania:

3.28.1 Wywotanie

<PartneriD>

identyfikator Klienta nadany
przez RUCH

(REQUIRED)10 char

<PartnerKey>

hasto Klienta nadane przez RUCH

(REQUIRED)10 char

Zwracane wartosci:

3.28.2 Odpowiedz

<Err> Numer btedu
<ErrDes> Opis btedu
<PaymentType> typ ptatnosci (POSTPAID lub PREPAID)

<CashOnDelivery>

pobranie (true/false)

<Insurance>

ubezpieczenie (true/false)

<DeliveryRUCH>

odbidr paczek (true/false)

<PackPrice>

cena za przesytke (w groszach)

<CODProvision>

prowizja za pobranie (w procentach)

<CODMinPrice>

minimalna prowizja za pobranie (w groszach)

<FirstName> imie
<LastName> nazwisko
<CompanyName> firma
<StreetName> ulica
<BuildingNumber> numer budynku
<PostCode> kod pocztowy
<City> miasto

<Nip> NIP
<PhoneNumber> numer telefonu
<EMail> adres email

<InsPrice100>

prowizja za ubezpieczenie do 100 PLN (w groszach)

<InsPrice300>

prowizja za ubezpieczenie do 300 PLN (w groszach

<InsPrice500>

prowizja za ubezpieczenie do 500 PLN (w groszach

<InsPrice1000>

prowizja za ubezpieczenie do 1000 PLN (w groszach)

59

API_ORLENPaczka_v_1_23_003




<InsPrice1500>

prowizja za ubezpieczenie do 1500 PLN (w groszach)

<InsPrice2000>

prowizja za ubezpieczenie do 2000 PLN (w groszach)

<InsPrice2500>

prowizja za ubezpieczenie do 2500 PLN (w groszach)

<InsPrice5000>

prowizja za ubezpieczenie do 5000 PLN (w groszach)

Przyktad:

<Err>000</Err>
<ErrDes>saved</ErrDes>

<PaymentType>POSTPAID</PaymentType>
< CashOnDelivery >false</ CashOnDelivery >

< Insurance >false</ Insurance >

< DeliveryRUCH >true</ DeliveryRUCH >
<PackPrice>850</PackPrice>
<CODProvision>0.95</CODProvision>
<CODMinPrice>150</CODMinPrice>
<FirstName>Jan</FirstName>
<LastName>Nowak</LastName>
<CompanyName>Firma SA</CompanyName>
<StreetName>Prosta</StreetName>

<BuildingNumber>1234</BuildingNumber>

<PostCode>99-999</PostCode>
<City>Warszawa</City>
<Nip>123-456-78-90</Nip>

<PhoneNumber>123456789</PhoneNumber>

<EMail>test@tt.pl</EMail>
<InsPrice100>0</InsPrice100>
<InsPrice200>0</InsPrice200>
<InsPrice300>0</InsPrice300>
<InsPrice500>100</InsPrice500>
<InsPrice1000>100</InsPrice1000>
<InsPrice1500>100</InsPrice1500>
<InsPrice2000>200</InsPrice2000>
<InsPrice2500>200</InsPrice2500>
<InsPrice5000>400</InsPrice5000>

3.29 GIVEPAYMENTTYPE

Metoda stuzy do pobrania typu ptatnosci klienta ORLEN Paczki.

Parametry wywotania:

3.29.1 Wywotanie

identyfikator Klienta nadany
<PartneriD> przez RUCH

(REQUIRED)10 char

<PartnerKey> hasto Klienta nadane przez RUCH | (REQUIRED)10 char

Zwracane wartosci:
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<Err> Numer btedu
<ErrDes> Opis btedu
<PaymentType> typ ptatnosci (POSTPAID lub PREPAID)
Przyktad:
<Err>000</Err>

<ErrDes>saved</ErrDes>

<PaymentType>POSTPAID</PaymentType>

3.30 GIVESHIPPINGCODESTATUS

Metoda umozliwiajgca sprawdzenie czy podany kod odbioru jest juz wykorzystany.

Parametry wywotania:

3.30.1 Wywotanie

<PartneriD>

identyfikator Klienta nadany
przez RUCH

(REQUIRED)10 char
<PartnerKey> hasto Klienta nadane przez RUCH | (REQUIRED)10 char
Lista kodéw nadania do
<Codes> sprawdzenia (REQUIRED) (ilos¢ 1...n)
<Codes> struktura
<string>

string

Przyktad z minimalng wymagana listg pol:

<PartnerID>1234567890</Partner|D>
<PartnerKey>XAGWEGWw12</PartnerKey>

<Codes>
<string>0431523</string>
<string>0256356</string>
</Codes>

Zwracane wartosci:

3.30.1 Odpowiedz

<ShippingCode>

kod nadania

<PackCode>

uzyty)

kod paczki powigzanej z kodem nadania (jesli kod
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| <CodeStatus> status kodu nadania

Przyktad:

<GiveShippingCodeStatus diffgr:id="GiveShippingCodeStatus1" msdata:rowOrder="0">
<ShippingCode>431512</ShippingCode>
<CodeStatus>wrong PartnerlD</CodeStatus>

</GiveShippingCodeStatus>

<GiveShippingCodeStatus diffgr:id="GiveShippingCodeStatus2" msdata:rowOrder="1">
<ShippingCode>256334</ShippingCode>
<PackCode>1234567890123</PackCode>
<CodeStatus>code used</CodeStatus>

</GiveShippingCodeStatus>

3.31 LABELPRINTDUPLICATE

Metoda stuzgca do ponownego pobrania etykiety zaawizowanej paczki.

3.31.1 Wywotanie

Parametry wywotania:

identyfikator Klienta nadany
<PartneriD> przez RUCH (REQUIRED)10 char
<PartnerKey> hasto Klienta nadane przez RUCH | (REQUIRED)10 char
<PackCode> numer kodu paczki zaawizowanej | (REQUIRED) 13 char

Przyktad z minimalng wymagana lista pol:
<PartnerID>1234567890</Partner|D>
<PartnerKey>XAGWEGWw12</PartnerKey>

<PackCode_RUCH>3400011619746</PackCode RUCH>

3.31.2 Odpowiedz

Zwracane wartosci:

<Err> numer btedu

opis btedu

211 - "Lack of routing data for this label"
212 - "No permission to this label number"

<ErrDes> 213 - "Parcel with this number already sent via Ruch"
Label dokument PDF szyfrowany BASE64 (jesli err=0)
Przyktad:
<Err>213</Err>
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<ErrDes> Parcel with this number already sent via Ruch</ErrDes>

<Label>null</Label>

3.32 LABELPRINTDUPLICATETWO

Metoda stuzgca do ponownego pobrania etykiety zaawizowanej paczki.

3.321 Wywotanie
Parametry wywotania:

identyfikator Klienta nadany

<PartnerID> przez RUCH (REQUIRED) 10 char
<PartnerKey> hasto Klienta nadane przez RUCH | (REQUIRED) 10 char
<Format> format etykiety (PDF lub EPL lub (REQUIRED) 5 char

PDF10 lub ZPL)
Numer kodu paczki
<PackCode> zaawizowanej (REQUIRED) (13 char)

Przyktad z minimalng wymagana listg pol:

<PartnerlD>1234567890</Partner|D>
<PartnerKey>XAGWEGWw12</PartnerKey>
<PackCode_RUCH>3400011619746</PackCode RUCH>

<Format>PDF</Format>

3.32.2 Odpowiedz

Zwracane wartosci:

<Err> Numer btedu
<ErrDes> Opis btedu
211 - "Lack of routing data for this label"
212 - "No permission to this label number"
213 - "Parcel with this number already sent via
Ruch"
Label Document PDF szyfrowany BASE64 (jesli err=0)

Przyktad:

<Err>213</Err>
<ErrDes> Parcel with this number already sent via Ruch</ErrDes>
<Label>null</Label>

3.33 LABELPRINTDUPLICATELIST

Metoda stuzgca do ponownego pobrania listy zaawizowanych paczek.
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3.33.1 Wywotanie
Parametry wywotania:

identyfikator Klienta nadany
<PartneriD> przez RUCH (REQUIRED) 10 char
<PartnerKey> hasto Klienta nadane przez RUCH | (REQUIRED) 10 char
<Format> format etykiety (PDF lub EPL) (REQUIRED) 3 char
<PackCodelList> Lista paczek (REQUIRED) (ilos¢ 1...n)

<PackCodelist> struktura

<PackCode> | Numer kodu paczki | (REQUIRED)13 char

Przyktad z minimalng wymagana lista pol:
<PartnerlD>1234567890</Partner|D>
<PartnerKey>XAGWEGWw12</PartnerKey>

<Format>PDF</Format>

3.33.2 Odpowiedz

PDF jest zwracany w Web.serwis jako output parameter.
Zwracane wartosci:

< PackCodelist > - lista paczek (1 ... n)

<Err> Numer btedu
<ErrDes> Opis btedu
211 - "Lack of routing data for this label"
212 - "No permission to this label number"
213 - "Parcel with this number already sent via
Ruch"

Label — dokument PDF szyfrowany BASE64 (jesli err=0)

Przyktad:
<Err>000</Err>
<ErrDes>saved</ErrDes>

<LabelData>base64</LabelData>

3.34 LABELPRINTDUPLICATELISTTWO

Metoda stuzgca do ponownego pobrania listy zaawizowanych paczek.
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3.341 Wywotanie
Parametry wywotania:

identyfikator Klienta nadany

<PartneriD> przez RUCH (REQUIRED) 10 char
<PartnerKey> hasto Klienta nadane przez RUCH | (REQUIRED) 10 char
<Format> format etykiety (PDF lub EPL lub (REQUIRED) 5 char

PDF10 lub ZPL)

<PackCodelist> Lista paczek (REQUIRED) (ilos¢ 1...n)

<PackCodelist> struktura

<PackCode> | Numer kodu paczki | (REQUIRED) 13 char

Przyktad z minimalng wymagana listg pol:

<Partner|D>1234567890</PartnerID>
<PartnerKey>XAGWEGWw12</PartnerKey>
<Format>PDF</Format>
<PackCodelList>
<string>2100012345678</string>
</PackCodelList>

3.34.2 Odpowiedz

PDF jest zwracany w Web.serwis jako output parameter.
Zwracane wartosci:

<PackCodelist> - lista paczek (1 ... n)

<Err> Numer btedu
<ErrDes> Opis btedu
211 - "Lack of routing data for this label"
212 - "No permission to this label number"
213 - "Parcel with this number already sent via
Ruch"
Label Document PDF szyfrowany BASE64 (jesli err=0)

Przyktad:
<Err>000</Err> 4

<ErrDes>saved</ErrDes>
<LabelData>base64</LabelData>

3.35 PUTCUSTOMERPACK

Metoda stuzgca do awizowania przesytki ORLEN Paczka z pobranej puli numerdéw.
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Parametry wywotania:

3.35.1 Wywotanie

<PackCode>

numer kodu paczki

(REQUIRED)13 char

<PartneriD>

identyfikator Klienta nadany
przez RUCH

(REQUIRED)10 char

<PartnerKey>

hasto Klienta nadane przez RUCH

(REQUIRED)10 char

<DestinationCode>

kod POPeR

(REQUIRED)15 char

<AlternativeDestinationCode> alternatywny kod POPeR 15 char
<ReturnDestinationCode> kod POPeR do zwrotu 15 char

<BoxSize> wielko$¢ paczki (REQUIRED) 10 char
<PackValue> wartosc¢ przesytki (w groszach) 6 char
<CashOnDelivery> paczka za pobraniem (true/false) boolean
<AmountCashOnDelivery> kwota pobrania (w groszach) 6 char

<Insurance> ubezpieczenie paczki (true/false) boolean
<EMail> adres email odbiorcy 60 char
<FirstName> imie odbiorcy 30 char
<LastName> nazwisko odbiorcy 30 char
<CompanyName> firma odbiorcy 70 char
<StreetName> ulica z adresu odbiorcy 30 char
<BuildingNumber> numer budynku z adresu odbiorcy | 10 char

numer mieszkania z adresu

<FlatNumber> odbiorcy 10 char

<City> miasto z adresu odbiorcy 30 char
<PostCode> kod pocztowy z adresu odbiorcy 6 char
<PhoneNumber> numer telefonu odbiorcy (REQUIRED) 9 char

<SenderEMail>

adres email nadawcy

(REQUIRED) 60 char

<SenderFirstName>

imie nadawcy

(REQUIRED) 30 char

<SenderLastName> nazwisko nadawcy (REQUIRED) 30 char
<SenderCompanyName> firma nadawcy 70 char
<SenderStreetName> ulica z adresu nadawcy (REQUIRED)30 char

numer budynku z adresu

<SenderBuildingNumber> nadawcy (REQUIRED)10 char
numer mieszkania z adresu
<SenderFlatNumber> nadawcy 10 char

<SenderCity>

miasto z adresu nadawcy

(REQUIRED) 30 char

<SenderPostCode> kod pocztowy z adresu nadawcy | (REQUIRED) 6 char
<SenderPhoneNumber> numer telefonu nadawcy (REQUIRED) 9 char
<SenderOrders> nr zamowienia nadawcy 30 char
<ReturnEMail> adres email do zwrotu 60 char
<ReturnFirstName> imie osoby do zwrotu 30 char
<ReturnLastName> - nazwisko osoby do zwrotu 30 char
<ReturnCompanyName> nazwa firm do zwrotu 70 char
<ReturnStreetName> ulica z adresu do zwrotu 30 char

numer budynku z adresu do
<ReturnBuildingNumber> zwrotu 10 char

numer mieszkania z adresu do
<ReturnFlatNumber> zwrotu 10 char
<ReturnCity> miasto z adresu do zwrotu 30 char
<ReturnPostCode> kod pocztowy z adresu do zwrotu | 6 char
<ReturnPhoneNumber> numer telefonu do zwrotu 9 char

<PrintAdress>

wybér adresu do wydruku przy
zwrocie (1- adres nadania, 2 -
adres zwrotu)

(REQUIRED) 1 char

<ReturnPack>

paczka zwrotna (T -jesli zwrotna)

1 char
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tytut przelewu dla paczki za

<TransferDescription> pobraniem 70 char
mozliwos¢ nadania paczki

<ReturnAvailable> zwrotnej (T -jesli tak) 1 char

<ReturnQuantity> liczba paczek zwrotnych 1 char

TransferDescription nie moze zawieraé polskich znakdéw i specjalnych.

Pola <FirstName> i <LastName> sg obowigzkowe jesli nie podano wartos¢ w polu <CompanyName>.

Pola <SenderFirstName> i <SenderLastName> sg obowigzkowe, jesli nie podano wartos¢ w polu

<SenderCompanyName>.

Pole < ReturnDestinationCode> wypetniane jest tyko w przypadku: nadania w PSD i wyborze innego

PSD do zwrotu niz PSD w ktérym paczka zostanie nadana.

Przy wyborze punktu odbioru APM oraz PKN, pole <BoxSize> jest obowigzkowe i przyjmuje wartosci: S,

M lub L.

Przyktad z minimalng wymagana lista pol:
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<PackCode >2900000000230</PackCode >
<PartnerlD>1234567890</Partner|D>
<PartnerKey>XAGWEGWw12</PartnerKey>
<DestinationCode>0130-6556-40-43</DestinationCode>
<FirstName>Jan</FirstName>
<LastName>Nowak</LastName>
<PhoneNumber>123456789</PhoneNumber>
<SenderEMail>test@tt.pl</SenderEMail>
<SenderCompanyName>Firma SA</SenderCompanyName>
<SenderStreetName>Prosta</SenderStreetName>
<SenderBuildingNumber>1234</SenderBuildingNumber>
<SenderCity>Warszawa</SenderCity>
<SenderPostCode>99-999</SenderPostCode>
<SenderPhoneNumber>123456789</SenderPhoneNumber>

<PrintAdress>1</PrintAdress>
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Zwracane wartosci:

3352 Odpowiedz

<Err>

Numer btedu

<ErrDes>

Opis btedu

<PackCode_RUCH>

Numer EAN-13 przesytki

<DestinationCode>

Kod POPER (potwierdzenie lub zmiana)

<Destinationld>

Kod PSD

<PackPrice>

Cena przesytki (w groszach)

<PackPaid>

Optacenie przesytki true/false

Przyktad:

<Err>000</Err>

<ErrDes>saved</ErrDes>

<PackCode_RUCH>2900000000230</PackCode_RUCH>

<DestinationCode>0130-6556-40-43</ DestinationCode>

<Destinationld>123680</ Destinationld>

<PackPrice>745</PackPrice>

<PackPaid>false</ PackPaid>

3.36 PUTCUSTOMERPACKCANCELED

Metoda stuzy do anulowania paczek wczesniej zaawizowanych do ustugi ORLEN Paczka.

Parametry wywotania:

3.36.1 Wywotanie

<PartneriD>

identyfikator Klienta nadany
przez RUCH

(REQUIRED) 10 char

<PartnerKey>

hasto Klienta nadane przez RUCH

(REQUIRED) 10 char

<PackCode>

numer kodu paczki zaawizowanej

(REQUIRED) 13 char

Zwracane wartosci:

3.36.2 Odpowiedz

<Err> numer btedu

<ErrDes> opis btedu

<PackCode> numer kodu paczki anulowane
Przyktad:
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<Err>000</Err>
<ErrDes>saved</ErrDes>

<PackCode >2900000000230</PackCode>

3.37 PING

Metoda stuzy do sprawdzenia stanu potgczenia z webservice’m API.

3.37.1 Wywotanie
Parametry wywotania:

BRAK |

3.37.2 Odpowiedz

Zwracane wartosci:

<PingResult> | Status potaczenia (true/false)

3.38 CALLPickUP

Metoda stuzy do zaméwienia podjazdu kuriera w celu odebrania paczek. Po wywotaniu tej metody
jest nawigzywane potaczenie z OpenNetApi.

3.38.1 Wywotanie
Parametry wywotania:

identyfikator Klienta nadany
<partneriD> przez RUCH (REQUIRED) 10 char
hasto Klienta nadane przez
<partnerKey> RUCH (REQUIRED) 10 char
lista numerow paczek
<packList> przeznaczonych do odbioru (REQUIRED) (ilos¢ 1...n)
data i godzina poczatku
<readyDate> gotowosci paczki do podjecia (REQUIRED) YYYY-MM-DDThh:mm:ss
data i godzina korica gotowosci
<pickupDate> paczki do podjecia (REQUIRED) YYYY-MM-DDThh:mm:ss

3.38.2 Odpowiedz
Zwracane wartosci:

<Err> numer btedu

<ErrDes> opis btedu

<Data> Numer kodu zlecenia
Przyktad:
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<Err>000</Err>
<ErrDes>Success</ErrDes>
<Data>13835004</Data>

3.39 CALLPICKUPNEW

Metoda stuzy do zamdwienia podjazdu kuriera w celu odebrania zamdéwien powstatych w systemie.

Po wywotaniu tej metody jest nawigzywane potgczenie z OpenNetApi.

3.39.1 Wywotanie

Parametry wywotania:

<PartneriD> identyfikator Klienta nadany przez RUCH (REQUIRED) 10 char

<PartnerKey> hasto Klienta nadane przez RUCH (REQUIRED) 10 char

<PackList> lista numerdw paczek przeznaczonych do odbioru (REQUIRED) (ilos¢ 1...n)

<ReadyDate> data i godzina poczatku gotowosci paczki do podjecia | (REQUIRED) YYYY-MM-DDThh:mm:ss
<PickupDate> data i godzina korica gotowosci paczki do podjecia (REQUIRED) YYYY-MM-DDThh:mm:ss
it kod pocztowy (REQUIRED) 6 char

<City> miasto (REQUIRED) 30 char

<Street> ulica (REQUIRED) 30 char

<BuildingNo> numer budynku 10 char

<Email> adres e-mail (REQUIRED) 60 char

<PartnerName> nazwa kontrahenta (REQUIRED) 30 char

<PersonName> imie klienta 30 char

<PersonSurname> nazwisko klienta 30 char

<Telephone> numer telefonu klienta 9 char

0
0'0

70

jesli PickupDate ma domyslng wartosc ("0001-01-01 00:00"), zwracany jest btagd z kodem
1052 (=MaxPickupDate is required);

jesli PickupDate jest ustawiony na niedziele, zwracany jest btad 1054 (=MaxPickupDate
cannot be set to Sunday);

jesli ReadyDate ma domysling wartos¢ ("0001-01-01 00:00"), zwracany jest btagd z kodem
1053 (=Wartos¢ ReadyDate nie zostata ustawiona);

jesli ReadyDate podamy jako wczes$niejszg godzine niz czas obecny, ustawiany jest obecny
czas gotowosci do podjazdu;

jesli ReadyDate jest wieksze lub réwne (pdzniejsze lub rowne) niz PickupDate, zwracany jest
btad 1055 (=MaxPickupDate HOUR cannot be smaller than ReadyDate HOUR).

jesli wskazany kod pocztowy nie istnieje lub istnieje, ale godzina podjazdu (parametr
MaxPickupDate) dla wyniku wywotania metody GetAvailablePickups wynosi 01:00:00,
zostanie zwrécony btad 400: Bad Request uniemozliwiajgcy zamowienie podjazdu dla tego
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kodu pocztowego. Dla takich kodéw pocztowych nie sg realizowane podjazdy w ustudze
ORLEN Paczki;

% jesli kod pocztowy, na ktéry nastepuje préba zamdwienia podjazdu znajduje sie w strefie C,
podjazd nie bedzie mozliwy oraz zostanie zwrdcony komunikat btedu 401 (=This Postal Code
does not have Pickup service enabled).

Przyktadowe wywotanie:

<Partnerld>PARTNERID</Partnerld>
<PartnerKey>PARTNERKEY</PartnerKey>
<PackList>

<string>2100000000001</string>

<string>2100000000002</string>
</PackList>
<ReadyDate>2023-06-09</ReadyDate>
<PickupDate>2023-06-09</PickupDate>
<PostCode>03-236</PostCode>
<City>Warszawa</City>
<Street>Annopol</Street>
<BuildingNo>17A</BuildingNo>
<Email>test@klient.pl</Email>
<PartnerName>Firma Testowa</PartnerName>
<PersonName>Jan</PersonName>
<PersonSurname>Testowy</PersonSurname>
<Telephone>123456789</Telephone>

3.39.2 Odpowiedz

Zwracane wartosci:

<Err> numer btedu
<ErrDes> opis btedu
<Data> Numer kodu zlecenia

Przyktadowa odpowiedzi:

<CallPickupNewResult>
<Err>0</Err>
<ErrDes>Success</ErrDes>
<Data>CPR12345</Data>

</CallPickupNewResult>

3.40 GETAVAILABLEPICKUPS

Metoda stuzy do pobrania listy najblizszych dostepnych dat i godzin podjazdow dla wskazanej
lokalizacji.

Przypisanie kodéw pocztowych w ramach organizacji podziatu strefowego:

STREFA kodu pocztowego

Czy sg organizowane podjazdy?

A

TAK
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B TAK
C NIE

R/

< W przypadku wskazania nieistniejgcego kodu pocztowego, zostanie zwrdcony btad
»PickupLocation post code is invalid”.

% Jesli kod pocztowy, na ktéry nastepuje préba zamowienia podjazdu znajduje sie w strefie C,

podjazd nie bedzie mozliwy oraz zostanie zwrdcony komunikat btedu 401 (=This Postal Code

does not have Pickup service enabled).

3.40.1 Wywotanie
Parametry wywotania:

<PartnerID> identyfikator Klienta nadany przez RUCH (REQUIRED) 10 char
<PartnerKey> hasto Klienta nadane przez RUCH (REQUIRED) 10 char
<PostCode> kod pocztowy (REQUIRED) 6 char
<City> miasto 30 char

<Street> ulica 30 char
<BuildingNo> numer budynku 10 char

<Email> adres e-mail 60 char
<PartnerName> nazwa kontrahenta 30 char
<PersonName> imie klienta 30 char
<PersonSurname> nazwisko klienta 30 char
<Telephone> numer telefonu klienta 9 char

Przyktadowe wywotanie:

<Partnerld>PARTNERID</Partnerld>
<PartnerKey>PARTNERKEY</PartnerKey>
<PostCode>03-236</PostCode>
<City>Warszawa</City>
<Street>Annopol</Street>
<BuildingNo>17A</BuildingNo>
<Email>test@klient.pl</Email>
<PartnerName>Firma Testowa</PartnerName>
<PersonName>Jan</PersonName>
<PersonSurname>Testowy</PersonSurname>
<Telephone>123456789</Telephone>

3.40.2 Odpowiedz

Zwracane wartosci:

<Data> dostepne podjazdy | AvailablePickupDay(]
<AvailablePickupDay> struktura
<Date> dzien podjazdu

<MinReadyDate> data i godzina poczatku gotowosci odbioru paczki
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<MaxPickupDate>

data i godzina korca gotowosci odbioru paczki

<Minimuminterval>

minimalny interwat miedzy zadeklarowanym MinReadyDate a
MaxPickupDate

<Err>

numer btedu

<ErrDes>

opis btedu

Przyktadowa odpowiedz:

<GetAvailablePickupsResult>

<Err>0</Err>

<ErrDes>Success</ErrDes>

<Data>

<AvailablePickupDay>

<Date>2023-06-02T700:00:00</Date>
<MinReadyDate>2023-06-02T11:00:00</MinReadyDate>
<MaxPickupDate>2023-06-02T13:00:00</MaxPickupDate>
<Minimuminterval>120</Minimuminterval>

</AvailablePickupDay>
<AvailablePickupDay>

<Date>2023-06-05T00:00:00</Date>
<MinReadyDate>2023-06-02T11:00:00</MinReadyDate>
<MaxPickupDate>2023-06-02T13:00:00</MaxPickupDate>
<Minimuminterval>120</Minimuminterval>

</AvailablePickupDay>

</Data>

</GetAvailablePickupsResult>

3.41 GIVEMESHIPPINGCODESTATUSFULLHISTORY

Metoda pozwalajgca pobrac petng historie paczki za pomocg kodu nadania.

3.41.1 Wywotanie

<ShippingCode>

kod nadania przesytki (REQUIRED) 7 char

<partneriD>

identyfikator Klienta nadany

przez RUCH (REQUIRED) 10 char

<partnerKey>

hasto Klienta nadane przez RUCH | (REQUIRED) 10 char

Zwracane wartosci:

3.41.2 Odpowiedz

<PackCode>

numer kodu paczki zaawizowanej

<Trans>

status paczki

<Trans_Des>

opis statusu

<Data>

data od kiedy paczka jest w statusie

<Destination>

kod POPeR

<Cl_From>

nr Centrum Logistycznego, na obszarze ktérego przesytka zostata
nadana

<Cl_From_Des>

CL, na obszarze ktérego przesytka zostata nadana
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<Cl> CL, na obszar ktérego przesytka zostata zaawizowana

<Cl_Des> nr CL, na obszar ktérego przesytka zostata zaawizowana

atrybut przesytki (MOBILNY — punkt mobilny, ALTERNATYWNY — punkt
alternatywny, ZMIENIONY — punkt zmieniony, POWROT — powrét
przesytki do kiosku nadania, 2_POWROT — powrét przesytki do

<Attribute> magazynu nadania, ZWROT — paczka zwrotna do magazynu nadawcy)
<StreetName> ulica na ktorej miesci sie Punkt Odbioru Paczek
<City> miasto gdzie miesci sie POP
<OpeningHours> informacja o godzinach otwarcia POP
<Location> opis lokalizacji Punktu Odbioru Paczek
Przyktad:

<PackCode>3400017462421</PackCode>

<Trans>200</Trans>

<Trans_Des>W Transporcie od Nadawcy</Trans_Des>
<Data>2021-01-08T09:03:00Z</Data>
<Destination>WR-561043-11-11</Destination>

<Cl_From>0000</Cl_From>

<Cl_From_Des />

<CI>9305</Cl>

<Cl_Des />

<Attribute />

<StreetName>KOLBERGA 1</StreetName>

<City>Jelenia Gdra</City>

<OpeningHours>Pn-Pt:07:00-17:00, S0:08:00-14:00, Nd: nieczynne</OpeningHours>
<Location>Kiosk z wejsciem, znajdujacy sie okoto 50 metrow od sklepu Jubilat. W poblizu skrzyzowanie z ulicg
Kartowicza prowadzacej do ul. Ogirskiego.</Location>

</PackStatus>

3.42 PUTCUSTOMERSHIPPINGCODECANCELED

Metoda pozwalajgca anulowac kod nadania.

3.42.1 Wywotanie
Parametry wywotania:

<ShippingCode> kod nadania przesytki (REQUIRED) 7 char
identyfikator Klienta nadany

<partneriD> przez RUCH (REQUIRED) 10 char

<partnerKey> hasto Klienta nadane przez RUCH | (REQUIRED) 10 char

3.42.2 Odpowiedz

Zwracane wartosci:

<Err> numer btedu
<ErrDes> opis btedu
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Przyktad:

<Err>000</Err>
<ErrDes>Saved</ErrDes>

4 KOMUNIKATY BLEDOW

100 |brak PartnerID

101 (brak PartnerKey

103 | brak PhoneNumber

104 |brak DestinationCode

105 [brak FirstName i LastName lub CompanyName
106 |brak PackCode

107 (brak PrintAdress

111 (brak SenderEMail

112 | brak SenderPhoneNumber

113 | brak SenderCity

114 |brak SenderStreetName

115 (brak SenderBuildingNumber

116 |brak SenderPostCode

117 |brak SenderFirstName i SenderLastName lub SenderCompanyName
120 (brak AmountCashOnDelivery

121 (brak TransferDescription

123 | brak ReturnCity

124 (brak ReturnStreetName

125 (brak ReturnBuildingNumber

126 |brak ReturnPostCode

127 |brak ReturnCompanyName

128 |brak ReturnAvailable

129 (brak ReturnQuantity

130 [niedozwolone znaki w AmountCashOnDelivery
131 [ niedozwolone znaki w TransferDescription
132 | niepoprawny format

133 [ niepoprawny PhoneNumber

134 (niepoprawny PackValue

135 | PackValue przekracza maksymalng wartos¢ ubezpieczenia
136 [ niepoprawny TransferDescription

137 | niepoprawny ReturnQuantity

138 [ niepoprawny PostCode

139 | missing PrintType

140 |nie moze by¢ zero w AmountCashOnDelivery
141 | nieprawidtowy gabaryt BoxSize

150 (przekroczona maksymalna liczba paczek

163 | brak PackCode i PhoneNumber

200 |niepoprawny PartnerID i/lub PartnerKey
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201 |juz byta anulowana

202 |juz nie moze by¢ anulowana

205 | nieznany PackCode

206 |nieznany DestinationCode

207 |nieznany ReturnDestinationCode

208 | klient juz istnieje

209 | niepoprawny PackCode

211 |lack of routing data for this label

212 | no permission to this label number

213 | parcel with this number already sent via Ruch

222 | Pack not found in Ruch system

223 | Pack does not belong to parnter

310 |no permission to COD

311 |no permission to Insurance

312 | no permission to Return

318 | no service COD in DestinationCode

1038 | Parametr PartnerName jest puste lub NULL

1039 [ Parametr Street jest puste lub NULL

1040 (Parametr City jest puste lub NULL

1041 | Parametr PostCode jest puste lub NULL

1043 ([ Parametr Email jest puste lub NULL

1052 [ Wartosc¢ PickupDate nie zostata ustawiona

1053 | Wartos$¢ ReadyDate nie zostata ustawiona

1054 | Wartos¢ PickupDate zostata ustawiona w niedziele

1055 [ MaxPickupDate HOUR cannot be smaller than ReadyDate HOUR
1067 |Incorrect interval's hours between MaxPickupDate and ReadyDate for this day
1077 | MaxPickupDate is invalid. Max available value for selected date: YYYY-MM-DD HH:MM:SS
1084 | Pickup not available for selected day

5 KOMUNIKATY OSTRZEGAWCZE, SWIADCZACE O POZYTYWNYM WYGENEROWANIU AWIZA

Pojawienie sie komunikatéw 006, 007 lub 008 swiadczy o nieaktualnej liscie punktéw ORLEN Paczka.

Pobranie aktualnej listy punktéw zniweluje pojawienie sie komunikatow. Nie sg to jednak btedy

uniemozliwiajgce wygenerowanie etykiety. Mimo ich pojawienia sie, etykieta wygeneruje sie

prawidtowo zas w pole DestinationCode zostanie podstawiona aktualna wartos¢ definiujgca dany

punkt.
000 Zapisano
006 Zapisano ale zmieniono DestinationCode
007 Zapisano ale zmieniono ReturnDestinationCode
008 Zapisano ale zmieniono DestinationCode i ReturnDestinationCode
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6 STATUSY PACZEK

100 W sortowni regionalne;j

110 W Transporcie do SC z Ekspedycji
193 Przekierowanie do APM

195 Przekierowanie do punktu

200 Zaawizowana do PwR

201 Anulowane awizo

210 Nadana w Kiosku

230 W Transporcie do Ekspedycji z Kiosku
240 W Transporcie do Ekspedyc;ji u kuriera
300 W Sortowni Centralnej

400 W Sortowni Centralnej

450 W Transporcie do Ekspedycji z SC
653 W Ekspedycji

660 W Transporcie do Kiosku u kuriera
665 Przekazana do Kiosku

677 Do nieczynnego kiosku

679 Niewydana Kierowcy

680 W Transporcie do Kiosku

689 Przekazana do Kiosku - niezarejestrowana
690 W Kiosku

695 W Kiosku SMS wystany

700 W Ekspedycji do SC

709 Powrét - Nieodebrana w Terminie
729 Powrét - Niepoprawny Kiosk

739 Nie przekazana do Kiosku

749 Reklamacja

790 Zwrot do ekspedycji

800 Zwrot do Sortowni

888 Archiwizacja

900 Zwrot do Nadawcy

9299 Zniszczona - zagubiona

1000 Odebrana przez Klienta

1100 Odebrana

1200 Odebrana - Zwrot

1220 Zwrot do nadawcy
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